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Avant-propos 
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en se basant sur la version anglaise d’ArcGIS 9.3, il peut être utilisé pour les versions 

ultérieures d’ArcGIS, anglophones ou francophones, moyennant quelques 
adaptations. 

 
Ce manuel et les données y afférentes sont libres de droit et redistribuables 

moyennant une mention de la source*. Ils sont téléchargeables gratuitement à 
l’adresse web : http://orbi.ulg.ac.be/handle/2268/135775. 
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Annexe 5. 
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Les mises à jour de ce manuel seront disponibles via l’adresse web ci-dessus. 
 

Version du 21 janvier 2016. 
 

Sont également disponibles, du même auteur, les manuels de Travaux Pratiques : 
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1. Introduction au TP 

L’objectif de ce TP est de vous rendre capable de réaliser les opérations suivantes sur des 
données géographiques à l’aide du logiciel « ArcGIS »: 

 Les organiser et les gérer  

 Les visualiser et les consulter (lecture) 

 Les modifier et en créer 

 Les analyser 

 Réaliser une modélisation  

 Cartographier (communiquer des données) 
 
Ce manuel commence par une brève introduction générale aux SIG  présentant  le concept 
de SIG, l’organisation générale d’ArcGIS et les formats et organisation des données en SIG.  
Ensuite la très grande partie des notes est consacrée à la manipulation de données 
géographiques selon un niveau croissant de complexité. La découverte progressive d’ArcGIS 
se fait la plupart du temps via des exercices s’articulant autour de mise en contexte donnant 
sens aux manipulations des données. Ces « Contextualisation » s’articulent autours des 
thématiques « pays du Sud » et « gestion de l’environnement » avec un accent pour la 
« gestion des risques naturels ». Elles apparaissent en italiques dans le texte, de même que 
les indications faisant référence à des données propre à ce TP (nom de fichier, de répertoire, 
etc). Elles commencent généralement par une mise en contexte en lien avec une 
problématique réelle, suivie d’une présentation des données à utiliser, pour terminer par 
des consignes précises pour résoudre le problème posé faisant référence aux sections 
contenant la description des outils/fonctions à utiliser. Ces contextualisations, de même que 
certaines données utilisées, sont fictives et souvent simplificatrices de la réalité.  
 
Quelques Notes (encadrées) et Remarques ponctuent les exercices les reliant parfois à des 
notions plus théoriques. 
 
Enfin, les quelques Annexes constituent un bon complément aux exercices, avec 
notamment  « Les 10 commandements » à respecter pour utiliser correctement ArcGIS! 
 
Avant de commencer ce TP, assurez-vous de : 

 Avoir accès à un ordinateur sur lequel le logiciel ArcGIS 9 ou suivant est installé, avec 
l’extension « Spatial Analyst ». 

 Téléchargez le dossier « Initiation ArcGIS SIG ACE » (~ 250 Mo), contenant les données 
utilisées dans ce manuel, disponible à l’adresse web : 
http://www.mcpedulg.ulg.ac.be/ressources.php et collez-le à la racine d’un disc dur de 
votre ordinateur (qui sera nommé « D » dans ce manuel). 

 
La réalisation de ce TP par un « débutant SIG » devrait prendre approximativement 12h de 
travail concentré.  

http://www.mcpedulg.ulg.ac.be/ressources.php
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2.  Introduction aux Systèmes 
d’Information Géographique – SIG. 

2.1. Qu’est-ce qu’un Système d’Information Géographique - 
SIG ? 

Les SIG sont considérés comme une des technologies de l’information les plus performantes 
car elle vise à intégrer des connaissances provenant de sources multiples et crée un 
environnement pluri-secteurs idéal pour la collaboration.  
 
De plus, le SIG séduit les nouveaux utilisateurs par son côté intuitif et cognitif. Il réunit un 
environnement de visualisation performant et une puissante infrastructure d’analyse et de 
modélisation spécialement adaptée à la géographie. 
 
Dans cette optique, les SIG proposent 3 volets pour afficher et manipuler les informations 
géographiques (voir figure 1) : 

 
Figure 1: Les 3 éléments constituant le noyau d’un SIG complet 

 

 Le volet géodatabase - catalogue : un SIG correspond à une base de données 
spatiales contenant des jeux de données qui représentent des informations 
géographiques selon un modèle de données SIG générique (entités, rasters, attributs, 
topologies, réseaux, etc.).  

 Le volet géovisualisation - carte : un SIG est un ensemble de cartes intelligentes (2D 
ou 3D)  et de vues (2D ou 3D)  qui montrent des entités spatiales et leurs relations à 
la surface de la terre. Il est possible d’élaborer différentes vues cartographiques des 
informations géographiques sous-jacentes, qui s’utilisent comme des “fenêtres 
ouvertes sur la base de données géographique” afin d’effectuer des requêtes, des 
analyses et de modifier les informations géographiques.  

 Le volet géotraitement – boite à outils: un SIG comprend des outils de 
transformation des informations qui produisent des informations à partir des jeux de 
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données existants. Les fonctions de géotraitement partent des informations 
contenues dans les jeux de données existants, appliquent des fonctions analytiques 
et écrivent les résultats dans de nouveaux jeux de données.  

 
Ensemble, ces trois éléments constituent le noyau d’un SIG complet.   

2.2. Qu’est-ce qu’ArcGIS 9.2 ? 

ArcGIS 9.2 est un logiciel de la firme ESRI , leader mondial des SIG. La figure 2 vous donne 
un aperçu de l’organisation de l’ensemble des produits ESRI. En rouge, sont entourés les 
composantes  que vous utiliserez au cours de ce TP. La version la plus simple du logiciel 
« ArcGIS desktop », « ArcView », comprenant les applications « ArcCatalog », « ArcMap »  et 
« ArcToolbox » ainsi que l’extension « Spatial Analyst ». Vous utiliserez bien sur des fichiers 
de données géographiques, notamment celles se trouvant sur un serveur internet de type 
« ArcIMS ». 
 

 
Figure 2 : What is ArcGIS? (Source: http://www.esribelux.com/index2FR.asp) 

2.3. Qu’est ce qu’ArcGIS Desktop ? 
ArcGIS Desktop (littéralement « ArcGIS de bureau ») comprend une suite d’applications 
intégrées les unes aux autres :  

1. ArcCatalog  facilite l’organisation et la gestion de toutes les données SIG (cartes, jeux 
de données, modèles,…) 

2. ArcMap  est l’application centrale d’ArcGIS Desktop. Elle se subdivise en deux 
interfaces : visualisation et traitement (analyse, édition,…) des données 
géographiques dans la fenêtre « data view » et  mise en page de cartes dans la 
fenêtre « layout view ». 

3. ArcGlobe, est similaire à ArcMap mais permet une visualisation 3D des données sur 
lesquelles vous travaillez. 
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4. ArcToolbox, (littéralement, la « boite à outils » d’ArcGIS), regroupe l’ensemble des 
outils de géotraitements utiles pour réaliser des opérations sur les données 
géographiques. Elle est disponible à partir des 3 applications présentées ci-dessus. 
ArcToolbox contient notamment le « ModelBuilder », un langage de programmation 
visuel et facile d’utilisation, pour automatiser  une suite de géotraitements 

 
En utilisant conjointement ces applications et ces interfaces, ArcGIS permet d’effectuer 
toutes sortes de tâches SIG, y compris la cartographie, l’analyse géographique, l’édition de 
données (création, mise à jour,…), la gestion des données, la visualisation et le 
géotraitement. 
 
Il est disponible à trois niveaux fonctionnels, du plus simple au plus perfectionné : 

1. ArcView est un outil SIG complet dédié à l’utilisation des données, la cartographie et 
l’analyse. 

2. ArcEditor permet la création et la mise à jour avancées de données géographiques.  
3. ArcInfo est un outil SIG bureautique professionnel et complet, qui propose des 

fonctions SIG complètes et de nombreux outils de géotraitement. 

Des fonctionnalités supplémentaires sont disponibles par l’activation d’une série 
d’extensions.  Les utilisateurs ont également la possibilité de développer leurs propres 
extensions. 

2.4. Rappel théorique 

2.4.1. Les 2 grands types de donnée géographique : Matriciel / 
Vectoriel 

Il existe 2 grands types de données géographiques dans les SIG : les « Matrices » et les 
« Vecteurs » (voir figure 3). 

 

 Vecteur  Matrice ou Raster Exemple dans la réalité 

 

 
 

Données linéaires : cours 
d’eau, routes,… 

 

 
Données ponctuelles : 
arbres, stations météo, 

points GPS,… 

Données polygonales : lacs, 
limites administratives 

(frontières de pays, limites 
de communes, etc.), parcs 

naturels,… 
Figure 3: Types de données géographiques : Vecteur versus Raster 
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 Les « Matrices » 
Les « matrices », plus souvent appelées « Raster », correspondent à des grilles 
composées de cellules. Chaque cellule contient une valeur qui, souvent, représente un 
phénomène géographique, par exemple, l’altitude ou l’occupation du sol. Ce peut être 
une carte scannée, une photographie aérienne, une image satellite, une photo 
numérique,… 
 

 Les « Vecteurs » 
Les « vecteurs » sont composés de points, lignes ou polygones. 

2.5. Données géographiques et tables associées 
Les SIG permettent d’associer / intégrer facilement des données de type spatial avec des 
donnés de type « tabulaire » (ou « attributaire ») (voir figure 4). A chaque entité spatiale 
correspond une / des information(s) attributaires organisées dans une « table ».  
 
 La figure 4 représente quelques pays d’Amérique Centrale, repris sous la forme d’entités 
spatiales de type « polygone », auxquels est associée toute une série d’informations 
organisées dans une table appelée  « table d’attributs ». 1 ligne ou « enregistrement » 
(« record » en anglais) contient toute l’information concernant 1 pays. 1 colonne ou 1 
« champ » (« field » en anglais) correspond à 1 type d’information, par exemple, le nom du 
pays, sa superficie, sa démographie, etc.  
 

 
Figure 4: Données géographiques et tables associées 
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3. Manipulation du logiciel ArcGIS 9.2. 

3.1. Exploration des données géographiques dans ArcCatalog 
Cette section 3.1: 

 Vous fera découvrir l’interface d’ArcCatalog,  

 Répondra aux questions suivantes concernant les fichiers de données 
géographiques :  

o Comment  sont-ils organisés ? 
o De quoi sont-ils composés ? 
o Comment les explorer ?  

Vous aurez de la sorte un bon aperçu et une bonne compréhension des fichiers avec lesquels 
vous allez travailler dans le cadre de ce TP. 
 
Ouvrez ArcCatalog : Démarrer > Tous les programmes > ArcGIS > ArcCatalog.  
 
Créez un lien vers votre répertoire de travail  afin d’accéder rapidement à vos données 
géographiques : 

 Cliquez sur l’icône  et naviguez ensuite vers le répertoire : « D:\ Initiation ArcGIS 
SIG ACE\DATA» contenant les données avec lesquelles vous allez travailler dans ce 
TP. 

Explorez dans un premier temps le répertoire « D:\Initiation ArcGIS SIG ACE\DATA\1 
ArcCatalog Data Exploration\ » (Figure 5). 
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3.1.1. L’interface d’ArcCatalog 

L’interface d’ArcCatalog s’organise de la façon suivante (Figure 5) : 
 

 
Figure 5 : Interface d’ArcCatalog et aperçu des différents types de fichiers 
 

1. Une fenêtre d’exploration de vos données géographiques, dont le fonctionnement 
général est similaire à celui de Windows Explorer (naviguer, copier, coller, déplacer, 
renommer,… vos données géographiques comme s’il s’agissait de fichiers uniques). De 
plus, cette fenêtre permet de réaliser des opérations de gestion de vos données 
spécifiques à ArcGIS, dont la création et l’organisation de nouveaux fichiers 
géographiques. 
 

2. Une fenêtre de visualisation de vos données géographiques, composée de 3 onglets : 

 « Content » renseigne sur le contenu du répertoire, ou le nom et le type de 
fichier sélectionné dans la fenêtre d’exploration 

 « Preview » permet la visualisation du contenu du fichier sélectionné. Le 
menu déroulant en bas à gauche de cette fenêtre vous donne le choix entre la 
représentation géographique du fichier (« Geography ») ou la table de 
données qui y est associée (« Table »).   

 « Metadata » permet de visualiser les métadonnées (données décrivant les 
données). 

 
3. Des barres d’outils permettant diverses opérations dont le démarrage d’ArcMap et 

ArcToolbox via les boutons , et des outils de visualisation de vos 

données . Dans les versions d’ArcGIS antérieures à la version 10, l’outil 

d’aide « Help tool »   permet d’obtenir des informations sur l’ensemble des 
fonctionnalités de la barre d’outils et de la barre de menu (cliquer dessus puis sur le 
menu déroulant ou l’outil sur lequel vous voulez avoir de l’information). Dans les 
versions d’ArcGIS 10 et suivante, le « Help tool » n’existe plus et est remplacé par le fait 
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que la description de la fonctionnalité liée à un bouton d’ArcGIS apparait 
automatiquement lors de son survol par la souris (parfois avec une explication plus 
complète en cliquant simultanément sur la touche F1 si indiqué). 

4. Une barre de menu permettant diverses opérations. 

3.1.2. Les types de données géographiques. 

Vous remarquer que, dans la fenêtre d’exploration, chaque type de données reconnues par 
ArcCatalog est renseigné par une icône spécifique (Figure 5). La Figure 5 reprend les types de 
fichiers les plus courants. 
 
Une définition précise des différents formats de fichiers utilisés dans ArcGIS est disponible 
dans l’aide d’ArcGIS  (cf. section 3.2) via le menu principal « Help > ArcGIS Desktop 
Help >… » : 

 « … > Sommaire > ArcGIS Glossary > et taper le nom du format »  

 « … > Index > Shapefile > described » par exemple. 
 
Explorez rapidement ensuite le reste du dossier « DATA » 

3.1.3. Manipulation de fichiers de données géographiques dans 
ArcCatalog 

Les fichiers de données géographiques ne sont pas de simples fichiers uniques. A 1 fichier de 
données géographiques (par exemple, 1 shapefile ou 1 raster) apparaissant dans ArcCatalog 
correspond plusieurs fichiers, visibles dans l’explorateur Windows. Ces fichiers sont 
complémentaires et contiennent chacun une partie de l’information géographique 
nécessaire pour une lecture correcte de « ce fichier » par ArcGIS (Figure 6).  
 

Aperçu du fichier Extension des fichiers associés Description des fichiers associés 

 
 

« Africa_countries_only » 

 

Africa_countries_only.shp  
(pour « SHaPe ») 

La géométrie, les entités 
géographiques 

Africa_countries_only.dbf 
 (pour « DataBaseFile ») 

Les données attributaires 

Africa_countries_only.prj 
(pour « Projection ») 

Le système de coordonnées 

Africa_countries_only.lyr 
 

La symbologie 

Africa_countries_only.shx L’index des enregistrements 

Africa_countries_only.sbn Index spatiaux n'existant qu'après 
une requête ou une jointure Africa_countries_only.sbx 

… .xml Les métadonnées (facultatif) 

…  
Figure 6 : Signification des extensions des différents fichiers constituants un fichier de données 
géographiques. 

 
Pour vous en rendre compte, comparez, dans ArcCatalog et dans l’explorateur Windows 
(Démarrer > Ordinateur > D >…), chacun des deux fichiers suivants : 
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o  « D:\Initiation ArcGIS SIG ACE \DATA\2 ArcMap project exploration\Africa 
countries only\ Africa countries only » 

o « D:\Initiation ArcGIS SIG ACE \DATA\2 ArcMap project exploration\MAP 
LIBRARY\ZAI_satellite_trimmed_TIF\ZAI_satellite_trimmed» 

 
ATTENTION ! Etant donnés qu’ « un » fichier de données géographiques est en fait composé 
d’un ensemble de fichiers complémentaires, il est important, lorsque vous déplacez, 
renommez,… vos fichiers de le faire via ArcCatalog qui réalisera l’opération comme s’il n’y 
avait qu’un seul fichier. En particulier, lorsque vous transmettrez vos données à un 
collaborateur, faites attention à lui transmettre l’ensemble des fichiers concernés sans quoi 
il ne pourra probablement pas utiliser correctement vos données. 

3.2. Aide dans ArcCatalog ou ArcMap. 

Outre le « Help Tool »  présenté précédemment, l’onglet « Help », et en particulier le 
menu « ArcGIS Desktop Help »  d’ArcCatalog et d’ArcMap contient toute une série 
d’informations très bien documentées afin d’aider l’utilisateur, citons notamment : 

 Une recherche de l’aide via un sommaire (livres), un index ou un menu de recherche 

 Un glossaire des termes utilisés dans ArcGIS (« GIS glossary ») 

 Des tutoriaux (dans le répertoire « Getting started > tutorials »)  

 … 
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3.3. Travailler dans ArcMap. 
 

Contextualisation 1  
Au secours d’un étudiant géographe ! 

 
Un de vos camarades de classe a manqué la première leçon d’initiation à ArcGIS et fait appel 
à vous car il rencontre quelques problèmes…Il a créé son premier projet ArcMap mais ne 
retrouve pas la mise en page d’une carte qu’il avait commencée, certaines données 
apparaissent dans le projet mais ne sont pas visualisables, etc… A vous de l’aider en suivant 
les indications reprises dans les sections 3.3.1 à 3.3.7 ci-dessous, indications qui vous 
apprendront également à ouvrir un projet ArcMap, à découvrir, comprendre et gérer son 
interface et à explorer des données géographiques. 
 
Contextualisation 1 : Au secours d’un étudiant géographe ! 

3.3.1. Ouvrir un projet ArcMap (nouveau ou préexistant) 

Ouvrez ArcMap. Deux possibilités s’offrent à vous (choisissez la deuxième !) : 

 Soit, cliquez sur « Démarrer > Tous les programmes > ArcGIS > ArcMap »  

 Soit, utilisez l’icône de raccourci vers ArcMap  disponible dans ArcCatalog 
o … et choisissez (choisissez la deuxième !) : 

o Soit, «Start using ArcMap with: A new empty map » pour ouvrir un 
nouveau document vide 

o Soit, «Start using ArcMap with: An existing map » pour ouvrir un 
document ArcMap préexistant, et ensuite «Browse for maps».  

 Naviguez ensuite vers le projet ArcMap préexistant dans le 
répertoire « D:\Initiation ArcGIS SIG ACE \DATA\2 ArcMap project 
exploration \ ArcMap project exploration.mxd » 

 Ouvrez ce projet 

3.3.2. Structure d’un projet ArcMap 

Vous devriez maintenant avoir en face de vous le projet ArcMap repris à la Figure 7 (sans les 
annotations rouges). 
 
L’interface d’ArcMap (en mode « Visualisation des données » ou « Data View ») s’organise 
de la manière suivante : 
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Figure 7: Structure de l'interface d'ArcMap en mode « visualisation des données » (data view) 

 

1. Une fenêtre appelée « Table des matières » (« Table of Contents ») reprenant une 
liste des fichiers présents dans le projet ArcMap. La « Table des matière » se 
subdivise elle-même en trois onglets :  

 « Display » pour sélectionner et organiser vos couches,   

 « Source » indiquant le répertoire dans lequel se trouvent les fichiers 

 « Sélection » ne reprenant que les fichiers sélectionnés pour l’affichage. 
2. Une fenêtre de visualisation spatiale des données sélectionnées dans la « Table des 

matières ». 
3. Une barre de menu comprenant toute une série de fonctionnalités sous forme de 

menus déroulant 
4. Des barres d’outils, permettant diverses opérations par l’intermédiaire de bouton.  
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La Figure 8 illustre le mode « Mise en page » (« Layout View ») d’ArcMap. Remarquez la 
présence d’éléments spécifique à une carte : titre, échelle, flèche du Nord, cadre. L’édition 
cartographique sera abordée à la section 3.3.24. 
 

 
Figure 8: Structure de l'interface d'ArcMap en mode « Mise en page » (« Layout View ») 

3.3.3. Afficher les couches (layers) d’information. 

Pour afficher / ne plus afficher une couche, il suffit de cocher / décocher la case située à 
gauche du nom de la couche. Remarquez qu’il est possible de tout (dé) cocher en appuyant 
sur « CTRL » en (dé)cochant une seule case.  

 Cochez/décochez, par exemple, la case à la gauche de la couche 
« 10m_river_lake_centerlines » 

 
Ne vous préoccupez pas encore des cases grisées des deux couches « ZAI » et 
« Africa_countries_only». Les cases grisées indiquent qu’ArcMap ne peut pas afficher la 
couche dans la fenêtre de visualisation. Nous y reviendrons plus tard. 
 
La fenêtre de visualisation d’ArcMap affiche les données géographiques sélectionnées dans 
la table des matières comme une superposition de couches les unes sur les autres selon 
l’ordre défini dans la table des matières (la première couche de la table des matières sera 
affichée au-dessus des autres dans la fenêtre de visualisation).  
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Pour vous en rendre compte, 

 Cliquez sur le nom de la couche « 10m_river_lake_centerlines » dans la table des 
matières et faites la glisser en-dessous de la couche « countries ». Que se passe-t-il ? 
(Réponse : la couche « 10m_river_lake_centerlines » est cachée par la couche 
« countries » qui se trouve au-dessus). 

 
Lors de l’addition de nouvelles données, ArcMap superpose par défaut les types de couches 
dans l’ordre suivant : points (au-dessus), lignes, polygones, raster(en-dessous). C’est le cas 
pour ce projet-ci. Pour modifier cet ordre, sélectionnez une couche en cliquant sur son nom 
et déplacez là en-dessous ou au-dessus de son emplacement initial. Que constatez-vous dans 
la fenêtre de visualisation ? 

3.3.4. Définir (Réparer) la source des données. 

Vous remarquez que la couche  « Africa_countries_only » est grisée avec un point 
d’exclamation rouge à côté. Ce point d’exclamation  signifie que le chemin (répertoire) 
reliant la couche visible dans ArcMap avec ses données sources (stockées sur votre disc dur) 
n’est pas correct et qu’en conséquences, ArcMap n’est plus capable d’afficher correctement 
cette donnée.  
 
Pour «  réparer » un « chemin source » d’une donnée, 

 Faites un bon vieux clic-droit sur le nom de la couche concernée, dans ce cas-ci 
« Africa_countries_only »   

 Allez dans « Data > Repair data source… ».  

 Naviguez ensuite (à l’aide de l’onglet « Look in ») jusqu’au répertoire où se trouve la 
donnée géographique correspondant à cette couche, dans ce cas-ci : « D:\Initiation 
ArcGIS SIG ACE \DATA\2 ArcMap project exploration\Africa countries only\ 
Africa_countries_only.shp » 

 Cliquez « Add ».  
La couche « Africa_countries_only » devrait maintenant s’afficher correctement dans la 
fenêtre de visualisation. La couleur grisée et le point d’exclamation rouge ont disparu.  

3.3.5. Définir la gamme d’échelle de visualisation d’une couche. 

La couche « ZAI » ne peut s’afficher elle aussi. Un petit rectangle avec un point se situant 
en-dessous de la case de la couche signifie que l’échelle actuellement utilisée dans la 
fenêtre de visualisation ne correspond pas à la gamme d’échelle dans laquelle cette couche 
peut s’afficher. L’échelle utilisée par la fenêtre de visualisation est visible à la droite du 

bouton  dans la barre d’outils « standard ». 
 
Afin de redéfinir la gamme d’échelle de visualisation d’une couche, et dans ce cas-ci de 
permettre la visualisation de la couche « ZAI » avec l’échelle actuelle, 

 Cliquez-droit sur le nom de la couche concernée, dans ce cas-ci « ZAI » 

 Allez dans « Properties… » 

 Choisissez l’onglet « General » et intéressez-vous à l’encadré « Scale Range ». 
Remarquez qu’actuellement, les paramètres de cet onglet sont réglés pour que cette 
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couche n’apparaisse pas lorsque l’on zoom à une échelle inférieure au 1/15 000 000 
(Zoom out). 

 Cochez « Show layer at all scales ». 

 Cliquez « OK » 
La couche « ZAI » devrait maintenant s’afficher correctement dans la fenêtre de 
visualisation, vous permettant de visualiser les régions administratives de la République 
Démocratique du Congo (RDC). 

 Rétablissez la gamme d’échelle de cette couche comme précédemment en choisissant 
cette fois : « Don’t show layer when zoomed out beyond 1 :15 000 000» et « OK ».  

La couche « ZAI » disparait. 

3.3.6. Navigation dans la fenêtre de visualisation. 

Plusieurs possibilités s’offrent à vous pour modifier l’échelle d’affichage : 

 Utilisez les outils  pour zoomer in, out et se déplacer latéralement. 
Zoomez sur l’Inde. 

 Cliquez sur   pour zoomer sur l’ensemble de vos données (affichées ou non). 

 Pour trouver facilement la RDC, faites un clic-droit sur le nom de la couche « ZAI » et 
choisissez « Zoom to layer ». 

 Pour retourner en Inde facilement, utiliser la flèche bleue de gauche de retour au 

zoom précédant .  

 Utilisez la flèche bleue de droite pour revenir en RDC. 

 Visualisez maintenant la RDC avec les 3 échelles suivantes : 1/24 000, 1/500 000, 
1/100 000 000 000. Pour ce faire, entrez les valeurs d’échelles désirées dans la boite 

« Scale » de votre barre d’outils principale, à la droite du bouton . Cela vous 
parait-il logique ? Qu’est-ce qu’une « grande » et « petite » échelle ? Réponse dans 
l’encadré ci-dessous. 

  Pour identifier un point dont vous avez les coordonnées utilisez l’outil « Go To XY » 

, de la barre d’outils « Outils » d’ArcMap. Pour identifier le « Sanctuaire des 
Bonobos » au Sud de Kinshasa :  

 Cliquez sur le bouton  

 Dans la fenêtre « « Go To XY (…)», 
o Choisissez des « degrés décimaux » comme unité 
o Tapez Long :15.266 et Lat :- 4.488 
o Choisissez l’outil « Zoom to » 

 

Question d’échelles !  
 Les petites échelles correspondent à de petites valeurs d’échelle, soit de grands dénominateurs dans les 

fractions représentants les échelles. Elles sont utilisées pour représenter de grandes surfaces avec peu de 
détails (ex : le monde au 1/200 000 000. Dans ce cas, 1cm sur la carte égale 200 000 000 cm dans le monde 
réel).  

 Les grandes échelles, inversement, seront utilisées pour représenter de petites surfaces avec beaucoup de 
détails (ex : un quartier au 1/10 000. Dans ce cas, 1cm sur la carte égale 10 000 cm dans le monde réel).  

Note 1 : Question d’échelle ! 
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3.3.7. Ajouter / enlever / déplacer une barre d’outils. 

Pour ajouter / enlever une barre d’outils, vous avez le choix : 
1. Soit 

 Cliquez sur le menu déroulant « Tools » de la barre de menu principale d’ArcMap 

 Choisissez « Customize… »  

 Cochez la case de la barre d’outils d’intérêt. (Tools par exemple) 

 Cliquez « Close » 
2. Soit 

 Cliquez sur le menu déroulant « View » de la barre de menu principale d’ArcMap 

 Choisissez « Toolbars» et  

 Cliquez sur la barre d’outils d’intérêt (Tools par exemple) 
 

Pour déplacer une barre d’outils : 

 Cliquez sur la petite barre verticale à l’extrémité gauche de la barre d’outils et 
déplacez-la avec la souris 

 
Fermez votre projet sans l’enregistrer. 

3.3.8. Ajouter / enlever une fenêtre ou un panneau 

Différents éléments de l’interface sont repris sous le vocable « fenêtre » ou « panneau ». Ils 
correspondent à (dans ArcMap): 

 La table des matières (« Table of content ») dans laquelle apparaissent tous les 
fichiers du projet ArcMap. 

 Le « Magnifier » qui joue le rôle de « fenêtre-loupe » 

 Le « Viewer » qui peut jouer le rôle d’une fenêtre de visualisation complémentaire 
indépendante  

 La fenêtre « Overview » qui permet de situer l’étendue actuellement affichée dans la 
fenêtre de visualisation principale  par rapport à l’étendue totale des données 
présentes dans le projet ArcMap en cours. 

 
Pour ajouter / enlever une fenêtre ou un panneau : 

 Dans le menu principal d’ArcMap/ArcCatalog, utilisez le bouton « Window » (fenêtre) 
et cliquez sur l’élément à faire apparaitre ou disparaitre. 
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Contextualisation 2  
Inondation au Pakistan suite à la rupture du  

barrage de Tarbela 
 
La vallée de l’Indus au Pakistan subi une importante inondation suite à la  rupture du 
barrage de Tarbela dans le district d'Haripur dans le Khyber Pakhtunkhwa. Les villages en 
aval subissent d’importants dégâts, notamment  la destruction des réserves de riz qui 
constituent la base de la nourriture des villageois. La famine menace.  
 Le Croissant Rouge désireraient identifier les villages les plus vulnérables pour prioriser les 
zones d’apport de nourriture par hélicoptère. 
Peu de données sont disponibles sur la région. Entre autre, un fichier Excel reprenant les 
coordonnées des villages le long de la vallée de l’Indus avec le type de construction, en terre 
ou en dur est disponible, de même qu’un fichier shapefile reprenant les zones touchées par 
la crue. 
→ Le Croissant Rouge vous demande, en tant que spécialiste en SIG, d’identifier les zones 
d’actions prioritaires, définies comme étant les villages en terre en aval du barrage de 
Tarbela. Vous devrez : 

 créer un nouveau projet ArcMap,  

 y insérer les données disponibles,  

 prendre connaissance de leur contenu informatif,  

 sélectionner les données sur la zone étudiée, 

  identifier les villages les plus vulnérables  

 et enfin produire un fichier les identifiant. 
 

                    
 
Contextualisation 2 : Inondation au Pakistan suite à la rupture du barrage de Tarbela 

3.3.9. Créer un nouveau projet ArcMap. 

Ouvrez un nouveau projet ArcMap (voir ci-dessus section 3.3.1), mais cette fois, choisissez 

 «Start using ArcMap with: A new empty map » 

 Enregistrez ensuite votre nouveau projet à l’aide de la commande « File > Save as » 
dans le répertoire de votre choix, dans ce cas-ci «D:\Initiation ArcGIS SIG ACE \DATA\ 

3 Add Attribute Selection\» et appelez-le « Tarbela_floods_VotreNOM.mxd ». 

3.3.10. Modification des propriétés du bloc de données dans 
ArcMap. 

A l’aide des indications ci-dessous, définissez des degrés décimaux comme unités des 
coordonnées géographiques de l’interface d’ArcMap. 

http://fr.wikipedia.org/wiki/District_d%27Haripur
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Les propriétés du bloc de données de l’interface ArcMap sont modifiables via un « clic-droit 

> Properties… » sur le bloc de données «  » en haut de la table des matières. 
Notez la possibilité : 

o Dans l’onglet « General », encadré « Units », de modifier les unités des 
coordonnées géographiques de l’interface d’ArcMap, coordonnées qui s’affichent 
en bas à droite de l’interface. 

o Dans l’onglet « General », « Name : », de modifier le nom du bloc de données. 
Appelez le « TARBELA » (facultatif).  

o De modifier le système de coordonnées du bloc de données : confer section 
suivante. 

3.3.11. Définition du système de coordonnées de l’environnement 
de travail dans ArcMap. 

La première chose à faire lors de la création d’un nouveau projet ArcMap est de définir le 
système de coordonnées dans lequel vous voulez travailler.  
 
Comme vous allez travailler sur une base de données mondiale exprimée dans le système 
« GCS WGS  1984 », utilisez ce système. 
 
Pour ce faire,  

 Faites un clic droit sur le « bloc de données » dans la « Table des 
matières » (« Table of contents ») 

 Allez dans « Properties… ».  

 Dans l’onglet « Coordinate System », vous constater qu’il n’y a encore aucun système 
de coordonnées défini pour ce projet (« No projection »). 

 Choisissez « Predifined \Geographic Coordinate Systems \World\WGS 1984 » 
 
Les informations sur ce système de coordonnées sont présentées dans la fenêtre « Current 
Coordinate System ».  

 Cliquez ensuite sur « OK » et vérifiez le nom et le système de votre bloc de données. 
 
Rem :  

 Si vous ne définissez pas d’entrée le jeu le système de coordonnées dans lequel vous 
voulez travailler dans votre « bloc de données », celui-ci utilisera par défaut le 
système de coordonnées de la première donnée que vous ajouterez dans ArcMap. 

 ArcMap gère facilement, dans une même interface, des fichiers exprimés dans des 
systèmes de coordonnées différents. 

 
A la « Remarque » clôturant la section 3.3.12.1 ci-dessous vous pourrez  visualiser l’effet 
d’un changement du système de coordonnées du bloc de données sur la représentation 
spatiale des données. 
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A propos des systèmes de coordonnées ! 
 
Un système de coordonnées géographique est  

 Un référentiel dans lequel on peut représenter des éléments dans l'espace. Ce 
système permet de se situer sur l'ensemble du globe terrestre grâce à un couple de 
coordonnées géographiques (Source : Wikipedia) 

 
On distingue habituellement les : 

 Systèmes de coordonnées géographiques (SCG-GCS) : qui utilisent 
une surface sphérique (à 3 dimensions) pour déterminer la position 
sur la terre à l’aide de coordonnées appelées « latitude » et 
« longitude » qui sont généralement exprimées en degrés et 
correspondent à des angles formés par les droites reliant le point à 
positionner à la surface de la terre, le centre de la terre et une 
origine à la surface de la terre définie par un méridien (de 
Greenwich souvent) et une parallèle (l’Equateur souvent) d’origine. 
(Figure : sphère) 

 Système de coordonnées projetées (SCP) : qui utilise une 
représentation plate (à 2 dimensions) pour déterminer la position 
sur la terre à l’aide de coordonnées « x,y » linéaires (des mètres par 
exemple) d’une grille ayant une origine propre au système. Le 
système de coordonnées projetées est toujours basé sur un SCG. 
(Figure : plan)  

 
Système UTM (Universal Transverse Mercator) 

 SCP très souvent utilisé 

 Il se situe dans le répertoire des systèmes de coordonnées d’ArcGIS« Predifined \ 
Projected Coordinate Systems \UTM\WGS 1984\... » réparti en zone Nord et Sud par 
rapport à l’équateur.  

 Voir également le fichier shapefile « utm_zones_final.shp » 
Système WGS 1984 

 SCG très souvent utilisé 

 Il se situe dans le répertoire des systèmes de coordonnées d’ArcGIS « Predifined 
\Geographic Coordinate Systems \World\WGS 1984 » 

 
En Belgique 

 En Belgique le sysème « Belge Lambert 1972 » est le plus traditionnellement utilisé. 

 Il se situe dans le répertoire des systèmes de coordonnées d’ArcGIS « Predifined \ 
Projected Coordinate Systems \ National grids \ Belge Lambert 1972 ».  

 Ce système a des mètres pour unité et prend son origine (point 0,0) au Sud-Ouest de 
la Belgique (Figure : plan) 

 Plus récemment le système « Belge Lambert 2008 » a été adopté. 
 
Le « système géodésique » (fr) ou « datum » (en) : permet d’incorporer les variations locales 
d’altitude non exprimée par le sphéroïde ou ellipsoïde (dérivé 3D d’une ellipse) qu’il 
accompagne. 
Note 2 : A propos des systèmes de coordonnées !

http://fr.wikipedia.org/wiki/R%C3%A9f%C3%A9rentiel_(syst%C3%A8mes_d%27information)
http://fr.wikipedia.org/wiki/Globe_terrestre
http://fr.wikipedia.org/wiki/Coordonn%C3%A9es_g%C3%A9ographiques
http://fr.wikipedia.org/wiki/Latitude
http://fr.wikipedia.org/wiki/Longitude
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De la gestion des systèmes de coordonnées des fichiers géographiques !  
 
2 fonctions sont très utiles pour la gestion des systèmes de coordonnées des fichiers 
géographiques (Cf. la section  3.3.20 concernant l’utilisation des outils de géotraitement). 
 
La fonction « Define Projection (management) »  

  Permet de définir le système de coordonnés dans lequel est déjà exprimé un 
fichier shapefile lorsque l’information sur ce système de coordonnées 
(normalement contenue dans le fichier avec l’extension « .prj ») est absente du 
fichier mais connue de l’utilisateur ! 

 A utiliser lorsque le système de coordonnées est inconnu d’ArcGIS: « Clic droit sur 
la couche > Properties > Sources > Coordinate System: Undifined ». Le message 
« Unknown Spatial Reference » apparait parfois lors de l’ajout dans ArcMap d’un 
fichier dont le système de coordonnées n’est pas défini. 

 Si vous ne connaissez pas le système dans lequel est exprimé le fichier, tentez 
d’obtenir l’information via la personne qui vous a fourni le fichier. Si l’information 
est manquante, le fichier risque de ne pas pouvoir être utilisable.  

 
La fonction « Project  (management) » :  

 Permet de projeter un fichier exprimé dans un certain système de coordonnées 
connu d’ArcGIS (et donc déjà défini) vers un autre système de coordonnées. 

 
Note 3 : De la gestion des systèmes de coordonnées des fichiers 

3.3.12. Ajouter des données. 

Vous allez ajouter les données disponibles dans votre projet ArcMap.  
 
Plusieurs méthodes existent pour ajouter des données dans ArcMap : 

3.3.12.1. Ajouter des données présentes sur votre PC à l’aide du bouton 
« Add data » 

 Cliquez sur le bouton  vous permettant d’ajoutez des données géographiques 
dans ArcMap. 

 Cliquez ensuite sur le bouton  vous permettant de créer une nouvelle connexion 
(un raccourci) vers votre répertoire de travail. Connectez-vous au répertoire où se 
trouvent toutes vos données, dans ce cas-ci : « D:\Initiation ArcGIS SIG ACE\DATA \ » 

 Cliquez OK 
Votre nouveau répertoire de travail apparait dans le « Catalog » de la fenêtre « Add Data ». 

 Naviguez ensuite jusqu’au répertoire contenant les données dont vous allez avoir 
besoin pour ce projet en particulier, dans ce cas-ci : « D:\ Initiation ArcGIS SIG 
ACE\DATA\3 Add Attribute Selection \ »  

 Sélectionnez toutes les données suivantes présentes dans ce répertoire: 
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o « 10m_river_lake_centerlines.shp » 
o « Indus_downstream_Tarbela_Dam_10km_buffer.shp » 
o « countries.shp», qui se situe dans le répertoire « D:\Initiation ArcGIS SIG 

ACE\DATA\1 ArcCatalog Data Exploration\SHAPEFILE\ » 

 Cliquez sur « Add ».  
Vos données s’ajoutent dans la fenêtre de visualisation. 
 
Visualisez vos données. Si nécessaire modifiez l’ordre des couches dans la table des matières 
pour que chacune des trois couches soit visibles. Zoomez sur la couche 
« Indus_downstream_Tarbela_Dam_10km_buffer.shp » (par exemple via un clic-droit sur le 
nom de la couche puis un « Zoom to layer »). Cette couche correspond à une zone tampon de 
10 km de part et d’autre du fleuve Indus en aval du barrage de Tarbela et est sensée 
identifier la zone maximale dans laquelle l’inondation risque d’avoir des conséquences graves 
sur les populations. 
 
Remarque : pour visualiser l’effet d’un changement du système de coordonnées du bloc de 
données sur la représentation spatiale des données: 

1. Zoomez sur l’ensemble des pays du monde 
2. Modifier le système de coordonnées du bloc de données (confer section 3.3.11 ci-

dessus) en choisissant successivement : 
a. Projected Coordinate Systems > World > Cylindrical Equal Area (world): 

projection cylindrique conservant les surfaces mais pas les distances et les 
directions.  

b. Projected Coordinate Systems > World > Equidistant Conic (world): projection 
conique ne conservant pas les surfaces 

c. Projected Coordinate Systems > World > Mercator (world): projection 
conservant les angles mais déformant les distances 

d. Projected Coordinate Systems > World > The World from Space: projection 
donnant une impression de globe 

e. Projected Coordinate Systems > National Grids > Europe > Belge Lambert 
2008: projection centrée sur la Belgique 

Les différents systèmes de coordonnées sont définis plus précisément dans l’aide online 
d’ArcGIS disponible ici: 
http://resources.arcgis.com/fr/help/main/10.2/index.html#/na/003r00000001000000/. 

3.3.12.2. Ajouter des données ponctuelles XY (GPS par exemple) à 
partir d’un tableur (Excel ou Access par exemple). 

Le fichier Excel « Populated_places_PAKISTAN.xls » reprend les principales zones peuplées du 
Pakistan. Ouvrez ce fichier dans Excel pour en avoir un aperçu. Ce fichier contient les 
informations suivantes : PPPTNAME, le nom des villages ; X_LONGITUD, la longitude des 
villages ; Y_LATITUDE, leur latitude ; Place_type, le type de construction principal rencontré 
dans la zone (« earth » : en terre ; « concrete » : en dur). 
Vous allez transformer ce fichier Excel en un fichier shapefile de points dans ArcMap. 
 
Pour importer des données ponctuelles à partir d’un tableur, 

 Cliquez sur le menu déroulant « Tool » dans la barre de menu principale d’ArcMap 

http://resources.arcgis.com/fr/help/main/10.2/index.html#/na/003r00000001000000/
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 Sélectionnez « Add XY Data… »  

 Naviguer vers votre tableur localisé dans « D:\Initiation ArcGIS SIG ACE\DATA\3 Add 
Attribute Selection\» et sélectionnez le tabler et la feuille du tableur d’intérêt. 

 Sélectionnez les champs de votre tableur qui correspondent aux coordonnées X et Y 
des points à importer. 

 Spécifier le système de coordonnées dans lequel sont exprimés vos points à l’aide du 
bouton « Edit… ». Dans ce cas-ci, vos points sont exprimés en « Predifined 
\Geographic Coordinate Systems \World\WGS 1984 »  en degrés décimaux. Deux 
possibilités s’offrent à vous (choisissez la deuxième) : 

o « Select », pour naviguer vers le système de coordonnées de vos points XY. 
o « Import », pour importer le système de coordonnées à partir d’un fichier de 

données géographiques déjà existant et ayant le même système de 
coordonnées que celui de vos points XY. Naviguez donc jusqu’au fichier 
« countries.shp 

 Cliquez « OK ». 
 

Les points s’affichent à présent dans ArcMap (sinon, faites un zoom to layer, cf. section 
3.3.6.) et la couche « Populated_places_PAKISTAN $ Events» s’est ajoutée dans la table des 
matières. Cette couche ne représente pas encore un « véritable shapefile » permanent et 
réutilisable. Pour en créer un, vous devez encore l’exporter.  
Pour exporter un shapefile : 

 Cliquez droit sur la couche à exporter comme shapefile, dans la table des matières, 
dans ce cas-ci « Populated_places_PAKISTAN $ Events» 

 Choisissez « Data > Export Data » 

 Gardez les options par défaut du menu d’exportation (« All features » et « this  layer’s 
source data ») 

 Choisissez d’enregistrez ces points dans le répertoire « D:\ Initiation ArcGIS SIG 
ACE\DATA\3 Add Attribute Selection \ ».  

 Nommez votre fichier « Populated_places_PAKISTAN.shp» 

 Cliquez « OK » 

 Ajoutez le fichier dans votre interface ArcMap 
 
!! Pour une procédure plus générale reprenant les conditions que la construction du tableur 
doit remplir, voir l’Annexe 4 « Fiche technique pour l’importation de points GPS (par 
exemple) dans ArcGIS à partir d’un tableur ».  
 

3.3.12.3. Ajouter des données disponibles sur un serveur accessible par 
Internet à l’aide  du bouton « Add data » et de « GIS Server ». 

(Cette section ne fait pas partie de l’exercice sur le Pakistan. Vous pouvez la sauter et y 
revenir plus tard.) 
 
Certaines organisations mettent toute une série d’informations géographiques en ligne à 
l’aide de server de type ArcIMS, accessible depuis l’interface d’ArcMap. 
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Cette section vous indique la marche à suivre pour vous connecter à un de ces serveurs 
réalisé par la Région Wallonne de Belgique, et en particulier pour avoir accès en mode 
visualisation au « Plan Photographique Numérique Communal » ou « PPNC ». 

 Cliquez sur  

 Cliquez sur  jusqu’à ce que vous remontiez à la boite « Catalog » dans le menu 
déroulant « Look in » de la fenêtre « Add Data ». 

 Cliquez sur    

 Etablissez la connexion avec le server d’intérêt en : 
o Cliquant sur le bouton « Add ArcIMS Server » 
o Entrant l’adresse internet suivante « http://cartopro1.wallonie.be » dans la 

fenêtre « URL of Server » 
o Cochant « Just the following-service(s) » 
o Cliquant sur « Get List » 
o Cochant le server « PPNC » 
o Cliquant OK 

Votre nouvelle connexion au serveur apparait dans la fenêtre « GIS 
Servers ». 

 Double-cliquez sur cette connexion 

 Cliquez sur le server « PPNC » 

 Cliquez « Add » 
Les données disponibles sur ce serveur s’affichent à présent dans ArcMap. L’étape de 
connexion au server ne devra pas être répétée lors de votre prochaine utilisation d’ArcMap. 
 

Une couche dans ArcMap = un lien qui pointe vers une donnée source ! 
 
Lorsque vous ajoutez des données dans ArcMap, vous ne faites que créer un lien qui pointe 
vers le fichier source et qui permet l’affichage de cette donnée source dans ArcMap. Un 
projet ArcMap (document .mxd) n’est qu’une interface à travers de laquelle vous pouvez 
réaliser des opérations sur vos données géographiques, dont l’enregistrement de votre 
mise en page (pour la réalisation d’une carte par exemple) et les propriétés de vos couches 
(symbologie,…) et des blocs de données (système de coordonnées,…). Mais il ne contient 
pas vos données. Une couche dans ArcMap n’est donc qu’un lien qui pointe vers une 
donnée source stockée sur un disc dur, une clef USB, etc. Un même fichier pour être affiché 
de différentes manières dans différents projets ArcMap coexistants. 
 
Note 4 : Une couche dans ArcMap = un lien qui pointe vers une donnée source ! 

3.3.13. La table d’attribut 

Les « données attributaires » d’un fichier de données géographique ou « Table d’Attributs » 
(le fichier .dbf) sont facilement accessibles dans ArcMap. Ces données sont utilisées 
fréquemment pour diverses opérations telles la sélection de données, l’utilisation d’une 
symbologie, etc. 
 

http://cartopro1.wallonie.be/
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Dans la table d’attributs (Figure 4), 1 ligne (ou un « enregistrement ») correspond à 1 entité 
spatiale. 1 entité spatiale peut être composée de plusieurs polygones ou lignes ou points, 
distincts spatialement. 
 

Accès à la table d’attributs. 
Deux possibilités s’offrent à vous pour accéder aux données attributaires dans ArcMap : 

 Ouverture de la « Table d’Attributs » 

 L’outil d’identification   
 
Prenez connaissance des informations présentes dans les tables d’attributs des  shapefiles du 
projet Pakistan (en particulier « Populated_places_PAKISTAN.shp ») à l’aide des indications 
ci-dessous. 

3.3.13.1. Ouverture de la table d’attribut. 

 Cliquez-droit sur le nom de la couche dont vous voulez visualiser la table d’attributs 

 Cliquez « Open Attributes Table » 
La table d’attributs de la couche s’ouvre. 
 

3.3.13.2. L’outil d’identification. 

 Cliquez sur l’outil d’identification  de la barre d’outils « Tools » 

 Cliquez ensuite sur l’entité spatiale pour laquelle vous désirez accéder à l’information 
de la table d’attribut.  

 Une fenêtre d’identification de cette entité spatiale apparait et présente toutes les 
informations de la table d’attribut de cette entité (correspondant à une ligne de la 
table d’attribut et à toutes les colonnes/attributs de la table). 

 
A l’aide de cet outil, identifiez le fleuve « Indus » dans le fichier « Pakistan 
10m_river_lake_centerlines.shp ». Par curiosité identifiez également les pays voisins du 
Pakistan dans le fichier « countries.shp ». 

3.3.14. Sélectionner des données. 

Afin de travailler sur un set de données réduit et d’y voir plus clair dans votre interface il peut 
être utile de sélectionner certaines entités spatiales d’intérêt pour pouvoir les exporter 
comme fichier indépendant.  
 

! 6ème commandement pour travailler correctement en SIG (voir l’Annexe 1 - ) 

Après avoir travaillé avec une sélection, il vaut mieux tout désélectionner à l’aide du bouton 

«  » afin de ne pas réaliser les opérations suivantes sur une sélection non désirée. 
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3.3.14.1. Sélection simple. 

Réalisez une sélection simple du pays Pakistan dans le shapefile « countries.shp » à l’aide des 
indications ci-dessous et exportez le comme  un nouveau fichier shapefile de polygones à 
l’aide des indications de la section 3.3.15 « Créer un fichier à partir d’une couche de 
sélection ». Vous appellerez ce fichier  «Pakistan.shp» que vous enregistrerez dans le 
répertoire répertoire « D:\ Initiation ArcGIS SIG ACE\DATA\3 Add Attribute Selection\». 
 ! Après la section 3.3.15, passez aux sections 3.3.14.2 et 3.3.14.3 ci-dessous.  
 
La méthode de sélection la plus simple consiste à sélectionner manuellement les entités 
spatiales. Ce type de sélection peut se faire de 2 façons,  

1. Soit dans la fenêtre de visualisation avec l’outil de sélection  (« Select Features 
Tool ») da la barre d’outils « Tools ». 

 Cliquez sur l’outil de sélection 

 Cliquez sur la / les entités à sélectionner 
Un clic-droit vous donne la possibilité de réaliser les opérations suivantes sur la / les 
entité(s) sélectionnée(s) : 
o Zoomer 
o Centrer sans zoomer  
o Tout désélectionner  

 
 
2. Soit dans la table d’attribut,  

 Cliquez sur le petit carré gris à l’extrême gauche de chaque ligne pour sélectionner 
l’entité correspondant à cette ligne 
Le bouton « Options » de la table d’attribut vous donne la possibilité de réaliser les 
opérations suivantes sur la / les entité(s) sélectionnée(s) : 
 
 
o Désélectionner  
o Inverser la sélection 
o Sélectionner toutes les entités 

 
Afin de faciliter une recherche dans la table d’attribut avant une sélection simple, vous 
pouvez réaliser un classement croissant ou décroissant de vos données selon un champ 

particulier, via les boutons  disponibles en cliquant-droit sur un entête de 
champ de la table d’attribut. 
 
Outre ces méthode de sélection simple, ArcMap permet de réaliser des requêtes de 
recherche / sélection d’entités sur base spatiale et attributaire (section suivantes). 

3.3.14.2. Sélection par Attribut. 

Vous allez créer un nouveau fichier shapefile ne contenant que les villages en terre (earth), 
identifiés comme les plus vulnérables. Pour ce faire réalisez une « sélection par attribut »  des 
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villages en terre dans le fichier « Populated_places_PAKISTAN.shp » à l’aide des indications 
ci-dessous et exportez la vers un nouveau fichier shapefile à l’aide des indications de la 
section 3.3.15 « Créer un fichier à partir d’une couche de sélection ». 
 
La sélection par attributs permet de sélectionner une / des entités spatiales sur base de leurs 
attributs à l’aide d’une requête de type SQL.  

 Cliquez sur « Selction > Select By Attributes… » dans la barre de menu principale de 
ArcMap 

 Choisissez dans le menu déroulant « Layer : » la couche dans laquelle vous voulez 
créer une nouvelle sélection, dans ce cas-ci, « Populated_places_PAKISTAN ». 

 Choisissez dans le menu déroulant « Method : » la méthode de sélection, dans ce 
cas-ci « Create a new selection », pour créer une nouvelle sélection. 

 Double-cliquez ensuite sur l’entête de champ [Place_type] dans le premier encadré 
blanc.  

[Place_type] doit apparaitre dans l’encadré blanc inférieur (« SELECT * FROM 
Populated_places_PAKISTAN WHERE : ») où s’écrit votre requête SQL au fur et à mesure que 
vous l’écrivez. 

 Simple-cliquez sur le bouton « = »,  

 Cliquez sur l’onglet « Get Unique Values » faisant apparaitre toutes les valeurs 
existantes pour le champ sélectionné dans le premier encadré blanc, ici [Place_type] 

 Double-cliquez sur « 'earth' » dans l’encadré blanc où sont apparus les types de 
constructions principaux dans les villages. 

Votre requête SQL doit être identique à « [Place_type] = 'earth' ». 

 Cliquez « OK ». 
Dans votre fenêtre de visualisation, les entités spatiales correspondantes à votre requête de 
sélection sont maintenant sélectionnées (pourtour en bleu clair par défaut). Pour le voir, la 
couche dans laquelle vous avez réalisez la sélection doit être rendue visible en la cochant 
dans la table des matières. 
 
Afin de vérifier que votre sélection est correcte: 

 Soit, cliquez sur l’outil d’identification puis sur quelques entités sélectionnées et 
vérifiez les informations apparaissant. 

 Soit, ouvrez la table d’attribut de la couche « Populated_places_PAKISTAN » (clique 
droit sur le nom de la couche « Communes » > Open Attributes Table ») et activez 
l’onglet « Selected » en bas de la table d’attribut pour n’afficher dans la table 
d’attributs que les entités (les villages dans ce cas-ci) sélectionnées (en bleu clair par 
défaut). 

 
La sélection par attribut est aussi directement disponible dans la table d’attributs des 
couches vectorielles : « Clic droit sur le nom de la couche > Open Attribute Table > onglet 
« Options » > Select By Attributes » et l’interface de sélection par attribut pour cette couche 
apparait.  
 

Le bouton « Find and Replace »  disponible dans les options de la table 
d’attributs vous permet de chercher et / ou remplacer une certaine valeur dans la table. 
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Une fois les villages en terre sélectionnés, passez directement à la section « 3.3.15.  Créer un 
fichier à partir d’une couche de sélection » et enregistrez les villages en terre dans un 
nouveau shapefile de points que vous appellerez «Populated_places_PAKISTAN_earth.shp » 
dans le répertoire « D:\ Initiation ArcGIS SIG ACE\DATA\3 Add Attribute Selection\». 

3.3.14.3. Sélection par Localisation 

La sélection par localisation permet de sélectionner une / des entités spatiales d’une couche 
sur base de la relation spatiale (position relative) de cette couche avec une autre couche.  
 
Vous allez sélectionner les villages en terre qui se situe dans la zone maximale dans laquelle 
l’inondation risque d’avoir des conséquences graves sur les populations, soit, en termes 
techniques, les villages en terre qui se situent dans la zone tampon identifiée par le fichier 
« Indus_downstream_Tarbela_Dam_10km_buffer.shp »  
 

 Cliquez sur « Selction > Select By Location… » dans la barre de menu principale de 
ArcMap 

 Choisissez dans le menu déroulant « I want to: », et la méthode de sélection, dans ce 
cas-ci « select features from » 

 Sélectionnez la couche « Populated_places_PAKISTAN_earth » dans l’encadré blanc 
« the following layer(s) : » 

 Sélectionnez « that : » « Intersect » dans le menu déroulant suivant 

 Sélectionnez « the features in this layer : » 
« Indus_downstream_Tarbela_Dam_10km_buffer» dans le menu déroulant suivant 

 Cliquez « OK » 
 
Vérifiez que vos données ont été correctement sélectionnées dans le fichier et créez un fichier 
« Populated_places_PAKISTAN_earth_RISK.shp »  à partir de cette sélection, à l’aide des 
indications de la section « 3.3.15.  Créer un fichier à partir d’une couche de sélection ». 
Enregistrez ce nouveau fichier dans le répertoire « D:\ Initiation ArcGIS SIG ACE\DATA\3 Add 
Attribute Selection\». Ce fichier répond à la demande du Croissant Rouge. Votre « Mission 
Pakistan » est accomplie.  ! 

3.3.14.4. Les autres fonctionnalités disponibles pour les sélections 

ArcMap propose d’autres fonctionnalités pour sélectionner ou agir sur une sélection. A vous 
de les découvrir via les chemins suivants : 

 Menu principal > Selection 

 Clic droit sur une couche > Selection 

 Dans la table d’attribut > menu « Option » 
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3.3.15. Créer un fichier à partir d’une couche de sélection ou 
Exporter un fichier. 

Si vous désirez créer un nouveau fichier à partir des entités que vous avez sélectionnées (ou 
simplement exporter des données vers un nouveau fichier), il vous suffit de : 

 Cliquer-droit sur le nom de la couche dont vous voulez exporter les entités 
sélectionnées (ou sur la couche sans entités sélectionnées dans le cas d’une 
exportation simple du fichier), 

 Choisir « Data > Export Data… »  

 Choisir d’exporter les entités sélectionnées (« Selected features ») en utilisant le 
même système de coordonnées que (« Use the same coordinate system as : ») la 
couche de données source (« this layer’s data source ») 

 Cliquer ensuite sur le dossier jaune pour enregistrez le nouveau « shapefile » que 
vous allez créer dans le répertoire de votre choix à l’aide de l’ « Output shapefile or 
feature class : » box, en lui donnant un nom approprié. 

 Cliquer « Save » 

 Cliquer « OK ». L’exportation prend un peu de temps. 

 Répondre « Oui » à la question « Do you want to add the exported data to the map 
as a layer ? », pour ajouter le shapefile nouvellement créé dans ArcMap.  

Votre nouveau fichier s’affiche dans ArcMap. 

 Supprimez (dans la table des matières : clic droit sur la couche > Remove) ou 
désactivez (décochez) éventuellement le fichier duquel est issu le nouveau fichier 
créé afin de mieux visualiser ce dernier dans l’interface d’ArcMap (facultatif). 
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Contextualisation 3  
Aide à la gestion de l’eau en milieu rural  

dans le centre du Mali 
 
La région de Dinangourou dans le centre du Mali, bien que se situant dans  
le Sahel, a toujours de par le passé pu satisfaire ses besoins en eau, tant les  
éleveurs que les cultivateurs maraichers. Cependant depuis quelques années, un 
changement climatique prononcé se traduit par une diminution conséquente des 
précipitations et une certaine tension s’est installée pour la répartition de l’accès aux puits, 
situation qui pourrait rapidement dégénérer en conflit. Face à cette situation, les chefs des 
12 villages de la région se sont réunis et ont décidé de prioriser l’accès aux 50 puits de la 
région sur base de la distance puits-village, règle ancestrale qui n’était plus d’application 
étant donné l’abondance en eau des années passées. Il fut donc décidé que chaque puits 
serait exploitable en priorité par le village le plus proche. Il est cependant important de noter 
que les éleveurs et les cultivateurs (irrigation) n’ont pas les mêmes besoins en eau, avec 30 
litres par jours par personne pour les éleveurs, et 50 litres par jour par personne pour les 
cultivateurs. Les différents puits fournissent des quantités d’eau journalières variant entre 50 
et 950 litres par jour.  
 

                     
 
→ Vous réalisez un stage de géographe dans une ONG basée à Gao, à l’Est de cette région, 
et vous avez eu vent de la problématique. Vous vous proposer d’apporter une aide aux chefs 
de villages via l’utilisation des SIG. Il vous faudra identifier de quel village chaque puits est le 
plus proche et établir un indice de satisfaction en eau pour chaque village sur base du mode 
de vie de leurs habitants (cultivateurs versus éleveurs),  de la démographie de chaque village 
et de l a quantité d’eau totale disponible par village sur base des puits les plus proches. 
 
Vous avez déjà rassemblé les données nécessaires à cette étude dans un projet ArcMap 
intitulé « Water management in Mali.mxd ». Les données et le projet ArcMap se situe dans 
le dossier « D:\Initiation ArcGIS SIG ACE\DATA\4 Join Relate Stats Compute in table».    
 
Vous disposez des fichiers suivants : 

 12_villages_around_Dinangourou.shp : shapefile reprenant les 12 villages de la 
région avec dans la table d’attribut, le nom des villages et leur démographie.  

 50_wells_around_Dinangourou.shp : shapefile reprenant les 50 puits de la région 
avec dans la table d’attributs, la quantité d’eau disponible en litres par jour. 

 12_villages_type_and_water_requirement.dbf: une table en format “.dbf” 
reprenant le nom des villages, le type de population (cultivateur (market gardener) 
versus éleveur (livestock farmer)), et les besoins en eau par personne du village en 
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litres par jour. Attention, ce fichier « .dbf » n’est visible dans la table des matières 
d’ArcMap que via l’onglet « Source » à activer en bas de la table des matières. Pour 
l’ouvrir faites un « clic droit > open ». 

 Cotton_parcel_Yanle.shp : les parcelles de cotons de quelques cultivateurs du village 
de Yanle. 

 
Les indications ci-dessous (sections 3.3.16 et 3.3.17) devraient vous permettre de réaliser ces 
différentes tâches. Un schéma des opérations à réaliser vous est également donné à la 
Figure 9 ci-dessous. 
 
Contextualisation 3 : Aide à la gestion de l’eau dans le centre du Mali 
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Figure 9: schéma des opérations de l’exercice « Aide à la gestion de l’eau en milieu rural dans le centre du Mali » 
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3.3.16. Jointure et Relation entre 2 tables. 

ArcMap fournit 2 méthodes pour associer entre elles différentes tables (table d’attributs ou 
autres tables) : 

 Jointure (« Joins ») : permet d’ajouter, dans la table d’attribut du fichier à partir 
duquel vous faites la jointure, les champs d’une autre table, sur base d’un champ 
contenant une information commune aux deux tables ou sur base spatiale. 

 Relation (« Relates ») : établi un lien, basé sur un champ contenant une information 
commune, entre deux tables mais n’ajoute pas les champs d’une table dans une 
autre. Les informations d’une table sont accessibles à partir de la table associée. 

 
Le joint / lien créé entre deux table est actualisé à chaque ouverture du document ArcMap 
contenant les tables jointes / reliées, de telle sorte que les modifications sont mises à jour. 

3.3.16.1. Créer une jointure entre 2 tables 

Deux types de jointures existent dans ArcMap : 

 Joint basé sur un attribut commun à 2 tables 

 Joint basé sur la localisation spatiale des entités de 2 fichiers 

 
Une même « ligne » de la « Table_2 » peut être associée à plusieurs « entités spatiales 
différentes » ou « lignes différentes de la table d’attribut » de la « Table_1 » (Figure 10 a).  
 
Dans le cas de jointure sur base attributaire, une seule « ligne » de la « Table_2 » peut être 
associée à une « ligne » donnée de la « Table_1 ».  
 
Dans le cas de jointure sur base spatiale, plusieurs « lignes » de la « Table_2 » peuvent être 
associées à une « ligne » donnée de la « Table_1 » via une agrégation des valeurs de la 
« Table 2 » en  utilisant une formule mathématique simple (somme, moyenne, etc) (Figure 
10 b).  

 
a           b 

Figure 10 : Mécanisme général de jointure dans ArcMap 
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3.3.16.2. Jointure basée sur un attribut commun à 2 tables 

Dans cette section, à l’aide d’une jointure attributaire, vous allez joindre au fichier 
« 12_villages_around_Dinangourou.shp » (« Table_1 »),  l’information sur le type de 
population et leur besoin en eau par personne contenue dans le fichier 
«12_villages_type_and_water_requirement.dbf  » (« Table_2 »)  en utilisant le champ 
commun « Village ».  
 

 
Figure 11 : Mécanisme de jointure basée sur un attribut commun à 2 tables dans ArcMap 

 
Pour établir une jointure basée sur un attribut commun à 2 tables  (Figure 11), 

 (Fermez la « Table_1 » si elle était ouverte) 

 Cliquez-droit sur le nom de la couche (« Table_1 ») à laquelle vous désirez joindre les 
données d’une autre table (« Table_2 ») 

 Choisissez « Joins and Relates > Join… » 

 Sélectionnez « Join attributes from a table » dans l’encadré « What do you want to 
join to this layer? » 
o Choisissez le champ de la « Table_1 » sur lequel vous coulez baser le joint 
o Choisissez la table à joindre à cette couche (« Table_2 »)  
o Choisissez le champ de la « Table_2 »  sur lequel vous voulez baser le joint 

 Cliquez « OK » 
En raison d’un problème inexpliqué (un bug d’ArcGIS ?), la « Table_1 » avec les informations 
jointes peut dans certains cas ne pas être lisible directement et présenter une table vide à 
l’ouverture. Pour résoudre ce problème,  

 Exportez la « Table_1 » contenant le joint dans un nouveau fichier, que vous 
appellerez « 12_villages_around_Dinangourou_JOIN_water_requ.shp » dans le 
dossier « 4 Join Relate Stats Compute in table ». 

 
Pour visualiser votre jointure, ouvrez la table d’attribut de la « Table_1 » ou du fichier 
exporté à partir de la table contenant la jointure. Vous constatez que les champs de la 
« Table_2 » ont été joints à la « Table_1 ».  
 
Pour annuler une jointure, cliquez-droit sur le nom de votre couche et allez dans « Joins and 
Relates > Remove Join(s) > » et sélectionnez le joint à supprimer. 
 
Pour sauver votre jointure dans un nouveau fichier, cliquez-droit sur le nom de votre 
couche et allez dans « Data > Export Data… »… 
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Vous obtenez donc le fichier « 12_villages_around_Dinangourou_JOIN_water_requ.shp »  qui 
pour chaque village reprend les informations de la démographie, du type de population et de 
leur besoin en eau individuel journalier. 

3.3.16.3. Jointure basée sur la localisation des entités de 2 fichiers 

Dans cette section, à l’aide d’une jointure spatiale, vous allez joindre à chaque puits du fichier  
« 50_wells_around_Dinangourou.shp  » (« Table_1 »),  les informations du  village le plus 
proche contenue dans le fichier 
« 12_villages_around_Dinangourou_JOIN_water_requ.shp »   (« Table_2 »).  
 
Pour établir un joint basé sur la localisation des entités de 2 fichiers 

 Cliquez-droit sur le nom de la couche (« Table_1 ») à laquelle vous désirez joindre les 
données d’une autre table (« Table_2 ») 

 Choisissez « Joins and Relates > Join… » 

 Sélectionnez « Join data from another layer based on spatiel location » dans 
l’encadré « What do you want to join to this layer? » 
o Choisissez la couche « Table_2 » à joindre à la couche « Table_1 » 
o Le point 2 du menu vous indique quel type de jointure vous réalisez  

o (dans le cas de l’exercice « Mali » : « Points to Points »).  
o Choisissez le type de jointure spatiale que vous désirer réaliser  

o (dans le cas de l’exercice « Mali » : la deuxième option) 
o Choisissez le répertoire et le nom de la couche que vous créez en réalisant cette 

jointure spatiale.  
o (dans le cas de l’exercice « Mali » : « Puits_villages_spatial_join.shp » dans 

le dossier « D:\Initiation ArcGIS SIG ACE\DATA\4 Join Relate Stats Compute 
in table») 

 Cliquez « OK » 
 
La table d’attribut du fichier que vous venez de créer contient les champs initiaux de la 
« Table_1 » et les champs joints de la « Table_2 ». Selon la méthode que vous aurez choisi, 
soit un « résumé » des attributs des entités de la « Table_2 », soit l’attribut de l’entité de la 
« Table_2 » la plus proche de l’entité de la « Table_1 » sera joint aux attributs de la 
« Table_1 ». 
 
La table d’attribut du fichier « Puits_villages_spatial_join.shp » vous indique donc à quel 
village est rattaché chacun des 50 puits de la région. 

3.3.16.4. Créer une Relation entre 2 tables 

(Cette section ne fait pas partie de l’exercice « Mali ». Elle est donnée à titre informatif.) 
 
Pour créer une relation entre deux tables, 

 Cliquez-droit sur le nom de la couche (« Table_1 ») à laquelle vous désirez relier les 
données d’une autre table (« Table_2 ») 

 Choisissez « Joins and Relates > Relate… » 
o Choisissez le champ de la « Table_1 » sur lequel vous voulez baser le lien 
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o Choisissez la table à relier à cette couche (« Table_2 ») 
o Choisissez le champ de la « Table_2 » que vous désirer relier à la « Table_1 » sur 

lequel vous coulez baser le lien 

 Nommez votre lien, par exemple « Relate 1 ». 

 Cliquez « OK » 
 
Vous pouvez accéder à cette relation de 2 manières différentes : 
1. Accéder à une relation par la table d’attribut 

 Ouvrez la table d’attribut de la couche « l » 

 Sélectionnez une entité spatiale / ligne 

 Allez dans « Options > Related Tables > Relate1 : Table 2 » 
La « Table 2 » s’ouvre avec les entités spatiales / lignes reliées sélectionnées. 
 

2. Accéder à une relation par l’outil d’identification  

 Cliquez  avec l’outil d’identification  sur une entité de la « Couche 1 » 

 Cliquez sur les signes « + » devant le nom de l’enregistrement sélectionné pour 
accéder aux informations de la table reliée correspondant à cette entité. 

3.3.17. Interroger une table d’attribut. 

3.3.17.1. Calculer des statistiques dans la table d’attributs 

Deux méthodes vous permettent d’obtenir des statistiques sur une table d’attributs. 
 

L’outil « Summarize » (résumer)  
L’outil « Summarize » va vous permettre de calculer  la somme des quantités d’eau 
disponibles par groupe de puits rattachés à chacun des villages. 
 
L’outil « Summarize » crée une nouvelle table contenant une seule ligne pour chaque valeur 
unique du champ sélectionné, et calcule les statistiques pour les autres champs. 

 Cliquez-droit sur l’entête d’un champ de la table d’attribut du fichier d’intérêt 
(Puits_villages_spatial_join.shp) 

 Cliquez sur « Summarize… » 
o Choisissez le champ à « résumer » (village) 
o Choisissez le / les champs pour le / lesquels vous voulez calculer des 

statistiques (quantité d’eau  journalière des puits, soit la colonne 
« Well_water ») 

o et choisissez le type de statistiques (Sum) 
o Nommez et enregistrez votre table de statistiques dans le répertoire de votre 

choix, « Somme_eau_par_village.dbf » dans le dossier « …\4 Join Relate Stats 
Compute in table» 

o Cliquez « OK » 

 Répondez « Oui » à la question « Do you want to add the result table in the map? » 
pour ajouter cette table dans votre table des matières, visible en mode « Source » 
seulement (onglet « Source » de la table des matières) car il n’y a pas de fichier de 
formes associé à cette table. 
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Observez cette table et faites vous une idée des quantités d’eau totale disponible par village. 

 
L’outil « Statistics » (statistiques). 
 
Utilisez l’outil « Statistics» pour avoir une idée de la distribution des quantités d’eau 
disponible dans chacun des puits en utilisant le fichier 
« 50_wells_around_Dinangourou.shp ». 
 
L’outil « Statistics » permet de calculer les statistiques principales (Nombre total, max, min, 
Somme, Moyenne, Déviation standard),  ainsi qu’un graphique de la distribution de la 
fréquence des valeurs d’un champ sélectionné. 

 Cliquez-droit sur l’entête d’un champ de la table d’attribut 

 Cliquez sur « Statistics… » 
 
Remarques : 

 Le calcul des statistiques pour un autre champ se fait directement via le menu 
déroulant « Field » de la fenêtre « Statistics of… ». 

 Si des entités sont sélectionnées, seules celles-ci seront prises en considération pour 
le calcul des statistiques. Si aucune entité n’est sélectionnée, elles seront toutes 
prises en considération.  

 Le calcul des statistiques d’une sélection peut se faire également à partir du menu 
déroulant « Sélection > Statistics… ». 

 
!! Réalisez une jointure attributaire (confer section 3.3.16.2) à partir du fichier 
« Puits_villages_spatial_join.shp », en utilisant comme joint le champ « village », vers le 
fichier « Somme_eau_par_village.dbf » afin d’ajouter dans le fichier 
« Puits_villages_spatial_join.shp », la somme des quantités d’eau disponibles par groupe de 
puits rattachés à chacun des villages et exportez le fichier résultat dans le dossier « …\4 Join 
Relate Stats Compute in table» sous le nom « Puits_villages_eau_disponible.shp ». 
 

L’outil « Create Graph… » (Création d’un graphique) 
 
L’outil « Create Graph… », disponible dans les « Options » de la table d’attribut, permet de 
créer toute une série de graphiques basés sur les informations de tables d’attributs. 
 
Utilisez l’outil « Create Graph… » pour avoir une idée des  quantités d’eau disponible par 
village en fonction de leur démographie. Pour ce faire, à partir de la table d’attributs du 
fichier « Puits_villages_eau_disponible.shp », appelez l’outil « Create Graph » et choisissez 
comme « Graph type » : « Scatter plot », avec comme «Y field » : « Sum_Well_water », et 
comme « X field (optional) » : « Demography », sans  « légende » et sans  « label » ou avec un 
label correspondant aux noms des villages, ce qui surcharge un peu le graphique. Dans le 
graphique obtenu (Figure 12), les villages en dessous de la droite de « y=x » présentent le 
moins bon rapport « eau disponible par habitant », et inversement pour les villages au-dessus 
de cette droite. 
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Graph of Puits_villages_eau_disponible

Demography; Village
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Figure 12 : Graphique obtenu avec l’outil « Crate Graph » 

3.3.17.2. Créer un nouveau champ dans la table d’attributs 

A la section suivante, vous allez calculer l’indice de satisfaction en eau pour chaque village. 
Avant de réaliser ce type de calcul, vous devez créer un nouveau champ dans la table 
d’attribut qui accueillera le résultat de ce calcul.  
 A l’aide des indications ci-dessous, créez 2 nouveaux champs dans la table d’attribut du 
fichier « Puits_villages_eau_disponible.shp »,  

1. Un champ que vous appellerez  « Besoin », qui exprimera les besoins totaux en eau 
par village en fonction de leur démographie et du type de population (cultivateur 
versus éleveur). Ce champ sera de type « Double » avec une « Precision » de 12, et 
une « Scale » de 0. 

2. Un champ que vous appellerez  « Indice », qui  exprimera l’indice de satisfaction en 
eau de chaque village. Ce champ sera de type « Double » avec une « Precision » de 
12, et une « Scale » de 3. 

 

 Ouvrez la table d’attribut de la couche (Cliquez-droit sur le nom de la couche > Open 
attribute Table) 

 Cliquez sur l’onglet « Options » 

 Choisissez « Add Field… » pour ajouter un champ à la table 
o (Si lors de l’ajout d’un champ, ArcMap affiche un message d’erreur indiquant que 

l’ajout est impossible car le fichier est en cours d’utilisation (un bug 
probablement), sauvez votre projet ArcMap et fermez le. Ensuite ouvrez 
ArcCatalog, naviguez jusqu’au fichier d’intérêt et dans la fenêtre de visualisation, 
passez en mode « Preview/Table » qui via le bouton « option » vous permettra 
d’ajouter le champ voulu. Une fois que c’est fait retournez dans ArcMap et 
continuez la procédure ci-dessous.) 

o Nommez votre champ (pas plus de 10 caractères, pas de caractères spéciaux, pas 
d’espaces (les espaces peuvent être remplacés par « l’underscore _ »)) 
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o Choisissez le « Type » de format que ce champ devra contenir, ainsi que la 
« Precision » et la « Scale » le cas échéant (Voir Tableau 1 ci-dessous pour plus 
d’informations)  

o Cliquez « OK » 
Le champ que vous venez de créer apparait comme dernière colonne de la table d’attribut. 
 

« Data Type » - Type de données Définition 
Intervalles de valeurs 

possibles 
Nombre 
d’octets 

« Short Integer » - Entier court 
Valeur numérique entière (sans 
décimal) dans un certain intervalle 

De -32 768 à 32 767 2 

« Long Integer » - Entier long 
De -2 147 483 648  

à 2 147 483 647 
4 

« Float » ou « Single-precision 
floating-point number » Valeur numérique décimale dans 

un certain intervalle 

Approximativement, de 
 -3.4E38 à 1.2E38 

4 

« Double » ou « Double-precision 
floating-point number » 

Approximativement, de  
-2.2E308 à 1.8E308 

8 

« Text » - Texte Caractères alphanumériques 

« Date » - Date Date et / ou temps 

« Precision » Nombre de chiffres maximum du champ (entiers et décimaux confondus) 

« Scale » - Décimalité 
Nombre de chiffres décimaux du champ. (Seulement pour les types 
« Float » et « Double ») 

« Lenght » - Longueur 
Nombre de caractères maximum du champ (seulement pout le type 
« Text ») 

Tableau 1: Types de données possibles pour les champs de la table d'attribut 

3.3.17.3. Utiliser la calculatrice de champ de la table d’attribut 

A l’aide des indications ci-dessous, réalisez 2 calculs  inter-colonnes à l’aide de la calculatrice 
de champ pour calculer les valeurs des champs « Besoin » et « Indice ». 

1. « Besoin » : utilisez la formule : [Demography] * [water_requ] 
2. « Indice » : utilisez la formule : [Sum_well_wa] / [Besoin] 

Vous obtenez de la sorte les indices de satisfaction en eau de chaque village et pouvez 
identifier les villages où un manque d’eau est à prévoir (valeur de l’indice < 1) si chaque 
village ne peut exploiter que les puits desquels il est le plus proche. « Mission Mali » 
accomplie  ! 
 
La calculatrice de champ permet de réaliser une gamme très variée d’opérations 
mathématiques se basant sur les valeurs reprises dans une ou plusieurs colonnes de la table 
d’attribut d’un fichier. 
 
Pour réaliser un calcul inter-colonnes,  dans la table d’attribut du fichier concerné,  

 Cliquez-droit sur l’entête de la colonne dans laquelle vous voulez enregistrer le 
résultat de votre calcul 

 Sélectionnez « Field Calculator… » (et répondez « yes » au message apparaissant) 

 Ecrivez la formule dans l’encadré « Nom de la colonne  = » à l’aide des menus 
disponibles 

 Cliquez « OK » 
La colonne cible se rempli des valeurs calculées. 
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3.3.17.4. Calculer les aires, périmètres, longueurs et centroïdes (ou 
coordonnées XY) d’entités spatiales. 

Contextualisation 3 – Suite et fin 
 

Certains habitants du village de Yanle cultivent quelques champs de coton bio, l’or blanc de 
l’Afrique, en plus de leurs légumes. Etant donné qu’ils reçoivent de la part des sociétés 
cotonnières des quantités d’engrais en fonction de leur superficie en coton, ils vous ont 
demandé d’évaluer à l’aide de votre SIG les superficies exactes de leurs parcelles de coton. 
Vous avez accepté. Un rapide relevé de terrain muni d’un GPS vous a permis de produire un 
fichier shapefile de polygones «Cotton_parcel_Yanle.shp »  représentant les parcelles de 
coton du village.  Zoomez sur cette couche à l’aide d’un « Clic droit > Zoom to layer » sur la 
couche pour la visualiser dans la fenêtre de visualisation. Suivez les indications ci-dessous afin 
de calculer les superficies des parcelles. Vous devrez préalablement, comme précédemment,  
créer la (les) colonne(s) qui accueillera les valeurs de superficie des parcelles.  
Créez donc une nouvelle colonne dans le fichier «Cotton_parcel_Yanle.shp »  que vous 
nommerez « Superficie », de type « Double » avec une « Precision » de 12, et une « Scale » de 
3 (confer ci-dessus). 
Attention, pour calculer des aires (superficies) ou périmètres, il faut que le système de 
coordonnées du bloc de données soit un système « projeté » et non pas un système 
« géographique » comme c’est le cas pour le moment (« GCS_WGS_1984 »). Changez donc le 
système de coordonnées du bloc de données en cliquant droit sur le bloc de données 

( ) et en allant dans « Properties… / Coordinate System / Projected Coordinate 
Systems / UTM / WGS 1984 / Northern Hemisphere / WGS_1984_UTM_Zone_30N ». Ce 
système projeté est adapté à la zone étudiée.  

 
L’outil « Calculate Geometry », disponible via un clic-droit sur l’entête d’une colonne dans 
une table d’attributs, présente des fonctions de calculs préenregistrés permettant de 
calculer les aires, périmètres, longueurs, centroïdes ou coordonnées XY, d’entités spatiales 
selon leur type (point, ligne, polygone). 
 

 Cliquez-droit sur l’entête de la colonne « aires » OU « Périmètres » OU « Centroïdes » 

 Sélectionnez « Calculate Geometry…» 

 Choisissez « Area » OU « Perimeter » OU « X Coordinate of Centroid » Ou « Y 
Coordinate of Centroid » 

 Choisissez le système de coordonnées à employer 

 Choisissez les unités (attention il y a un bug dans ArcMap 9.3 : si vous utilisez des 
hectares pour calculer des superficies ArcMap calcul la superficie au carré) : utilisez 
plutôt des km² par exemple). 

 Cliquez « OK » 
 
Tapez « Field Calculator » dans l’index de l’ « ArcGIS Desktop Help » et choisissez « Field 
Calculator dialog (table window)». Remarquez qu’il est possible de calculer aires, périmètre, 
etc, à l’aide de la calculatrice de champ (section « Common VBA geometry calculations in the 
Field Calculator ») et de réaliser des calculs avancés à l’aide de lignes de codes en VBA. 
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Contextualisation 4  

SIG Participatif aux Philippines 
 

L’ONG philippines « ACE » vous demande de réaliser l’insertion dans un SIG du 
 plan d’aménagement du territoire qu’elle a élaboré avec la communauté de  
pêcheurs et d’agriculteurs du village d’Akbar sur l’île de Basilan aux Philippines, dans le cadre 
de son projet de développement rural, au cours d’un atelier de SIG participatif et de 
cartographie communautaire. Les aménagements clefs identifiés par les villageois sont :  

 l’implantation de 4 éoliennes (windmill),  

 l’installation de 3 points d’eau potable (water point), 

 l’aménagement d’un potager biologique communautaire (organic vegetable garden),  

 l’installation d’un réseau d’égouttage pour les eaux usées (sewerage)  
L’ONG a demandé à la communauté de dessiner au marqueur ces aménagements aux 
endroits voulus sur une image satellitaire issue de Google Earth. La carte a été légendée, 
scannée, puis géoréférencée dans ArcGIS. Cette carte est disponible en format « .tif » (raster) 
dans le répertoire « … DATA\5 Edition et création de données\ 
AKBAR_Community map_GEOREF.tif ».  
 

 
Figure 13 : Plan d’aménagement du territoire réalisé via un atelier de SIG participatif 
communautaire dans le village d’Akbar sur l’île de Basilan aux Philippines et aperçu du village. 

 
Aidez-vous des instructions ci-dessous (section 3.3.18) pour insérer ces éléments dans votre 
SIG. Attention, de choisir le bon format de fichier shapefile pour chaque type 
d’aménagement : 

 Eolienne et point d’eau : shapefile de type « point » 

 Parcelles de potager : shapefile de type « polygone » 

 Réseau d’égouttage : shapefile de type « line » 
Remarquez qu’on vous demande d’intégrer les 4 éoliennes dans le fichier « Basilan windmill 
project.shp » reprenant les éoliennes en projet de construction de l’île. 
 
Démarrez votre travail en explorant les données présentent dans le projet ArcMap 
« Participatory GIS Philippines.mxd » disponible dans le répertoire « … DATA\5 Edition et 
création de données ». 
Contextualisation 4 : SIG participatif aux Philippines 
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3.3.18. Edition et création de données géographiques. 

3.3.18.1. Edition (modification) de données dans ArcMap. 

Une fois ouvert le projet ArcMap « Participatory GIS Philippines.mxd » disponible dans le 
répertoire « … DATA\5 Edition et création de données », à l’aide des indications ci-dessous, 
éditez le shapefile « Basilan windmill project.shp » dans lequel vous ajouterez les 4 éoliennes 
d’Akbar. Il vous faudra zoomer sur la zone où se trouve les éoliennes à créer et les 
« dessiner » via l’ajout de points identifiant leur localisation. 
 
ArcMap permet de modifier des fichiers de données existants, par exemple : 

 Ajouter un nouveau polygone représentant une nouvelle construction pour la mise à 
jour d’un shapefile de polygones reprenant les habitations d’une ville. 

 Modifier le tracé d’une ligne représentant une rivière qui aurait été détournée, dans 
un shapefile représentant le réseau hydrographique d’une région. 

 Supprimer des points identifiants des arbres remarquables qui viennent d’être 
arrachés par une tempête. 

 
TOUTES les couches d’un même répertoire, d’un même espace de travail, ou d’une même 
géodatabase peuvent être mise à jour dans une même session d’édition.  
 

Pour éditer un fichier,  
 Remarque préliminaire : la procédure décrite ci-dessous correspond aux versions 

d’ArcGIS antérieures à la version 10. Les outils d’édition se présentent quelque peu 
différemment pour les versions 10.0 et suivantes mais restent très intuitifs. 

 Faites apparaitre la barre d’outils « d’édition des données géographiques » (confer 
figures ci-dessous pour ArcGIS 9.2 et 10.1) : 

o Soit, cliquez sur le bouton de raccourcis  
o Soit, Cliquez sur le menu déroulant « View » de la barre de menu principale 

d’ArcMap et Choisissez « Toolbars > Editor »  
 

ArcGIS 9.2 
 

ArcGIS 10.1 
 

 Ajoutez (si ce n’est déjà fait) dans votre projet ArcMap le fichier que vous voulez 
éditer. Si ce fichier est un fichier nouvellement créé dans ArcCatalog, sans entités 
spatiales, rien n’apparaitra dans la fenêtre de visualisation mais le fichier viendra 
s’ajouter comme une nouvelle couche « vide » dans la table des matières. 

 Cliquez sur « Editor > Start Editing » de la barre d’outil « Editor » pour commencer 
une session d’édition de vos données géographiques. 

 Sélectionnez, dans la fenêtre « Start Editing » qui s’ouvre, le répertoire source 
« Source » qui contient le fichier que vous voulez éditer. Les fichiers contenus dans le 
répertoire que vous pouvez sélectionner dans la colonne « Source » s’affiche dans 
l’encadré gris du dessous.  

 Cliquez « OK » 
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 (Sélectionnez votre fichier dans la fenêtre « Starting To Edit In a Different Coordinate 
System » si celle-ci apparait.) 

 Cliquez sur le bouton « Start Editing »  
La barre d’outils d’édition « Editor » est maintenant activée. Avant d’éditer vos données 
à proprement parler, réglez les paramètres de cette barre d’outils : 

 Sélectionnez, dans le menu déroulant « Target : » (cible), le fichier que vous voulez 
éditer. 

 Sélectionnez, dans le menu déroulant « Task » (tâche) le type d’opération que vous 
voulez réaliser, « Create New Feature » si vous voulez « créer une nouvelle entité ») 

Et 

 Zoomez sur la partie à éditer. Au plus vous zoomerez, au plus votre édition sera 
précise. 
o Vous pouvez également choisir une « Snapping Tolerance », c’est-à-dire une 

distance à partir de laquelle 2 « vertex » sont fusionnés automatiquement (Cf. ci-
dessous la section « Définir l’environnement de capture d’une session 
d’édition »). 

 
Les outils utiles à l’édition spatiale de vos données sont disponibles dans  
le menu déroulant « Sketch Tool »  (illustration à droite).  

Le crayon permet de dessiner des points, lignes (ensemble de points  
reliés non fermé) ou polygones (ensemble de points reliés et fermé).  

 Un clic-droit crée un vertex (= point constitutif d’une entité spatiale).  

 Le dernier vertex créé est rouge.  

 Pour terminer une ligne ou un polygone, faites un double-clic gauche.  

 Pendant la construction d’une entité, un clic-droit vous donne accès à une série 
d’option de dessin dont le « Delete Sketch » pour effacer l’entité que vous 
construisez et le « Finish Sketch » pour terminer votre entité.  

 Les flèches  peuvent également être utilisées pour effacer / recréer un vertex 
ou une entité. 

 Lors du dessin de lignes ou polygones, la touche F8 vous permet de passer en mode 
« streaming » pour dessiner facilement des courbes de manière continue. 

La flèche noire « Edit tool »  vous permet de :  

 sélectionner l’entité à éditer (simple clic) et  

 d’en faire apparaitre les « vertex » (double-clic) 

 L’entité sélectionnée peut-être supprimée (« clic-droit  sur l’entité sélectionnée à 
supprimer > Delete ») ou éditée (pour déplacer un vertex, placez-vous au-dessus, 
sélectionnez-le et déplacez-le ; pour supprimer un vertex : « clic-droit sur le vertex > 
Delete Vertex » ; pour insérer un vertex : « clic-droit sur le périmètre de l’entité > 
Insert Vertex ». 

Pour sélectionner une entité en mode édition sans risque de la déplacer par un faux 

mouvement, utilisez la flèche de sélection  plutôt que la flèche d’édition . 

 Zoomez sur l’endroit à éditer dans la fenêtre de visualisation 
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Définir l’environnement de capture d’une session d’édition. 
Lorsque le dessein de certaines entités spatiales requière une certaine précision, pour que 
par exemple des entités soient parfaitement jointives, il est nécessaire d’activer l’outil 
« Snapping » (ajustement automatique) contrôlant une session d’édition. Cet outil permet 
de définir une « Snapping tolerance » (une distance) à partir de laquelle 2 « vertex » (= point 
constitutif d’une entité spatiale) voisins sont fusionnés automatiquement. Afin d’utiliser 
cette fonctionnalité : 

1. Il faut qu’une session d’édition soit ouverte 
2. Réglez la « Snapping tolerance »  via le menu « Editor > Options… > General > 

Snapping tolerance: » en indiquant la valeur souhaitée. 
3. Définissez le(s) fichier(s) sur lesquels appliquer le « snapping » et le type de 

« snapping » (« Vertex », « Edge », « End ») via le menu « Editor > Snapping… » en 
cochant les cases adéquates. 

 

Edition de la table d’attribut. 
En mode édition, vous avez aussi accès à la table d’attribut si vous voulez éditer les 
informations sur les entités spatiales que vous modifiez / créez.  

 Vos éditions dans la table d’attribut devront respecter le format prédéfinis des 
colonnes (texte, date, chiffre entier, chiffre décimal, etc). 

 Il n’est pas possible d’ajouter un nouveau champ lorsqu’une session d’édition est 
ouverte. Pour ajouter un nouveau champ dans une table d’attribut, fermez la session 
d’édition encours et ajouter le champ. Rouvrez une session d’édition pour éditer ce 
champ. 

 Pour visualiser l’entité spatiale que vous éditez dans la table d’attribut, sélectionnez-
la, 

o Soit, dans la fenêtre de visualisation, à l’aide de la flèche de sélection  
o Soit, dans la table d’attribut, en cliquant sur le carré gris à gauche de la ligne 

identifiant l’entité 
 

Sauvez et terminer une session d’édition 
A la fin d’une session d’édition, il est important de sauver les modifications réalisées. Pour ce 
faire, dans la barre du menu d’édition, cliquez sur : 

 «  Save Edits », puis 

 « Stop Editing » 

3.3.18.2. Création de nouvelles données dans ArcCatalog. 

A l’aide des indictions ci-dessous, vous allez créer 3 nouveaux shapefiles qui accueilleront les 
informations relatives aux points d’eau potable, au potager biologique communautaire et à 
l’installation du réseau d’égouttage. Il vous faudra d’abord créer ces shapefiles dans 
ArcCatalog, puis les éditer, comme  ci-dessus avec les éoliennes, dans ArcMap. Vous 
travaillerez dans le répertoire « … DATA\5 Edition et création de données ».  
Pour la création de fichier dans ArcCatalog, passez les sections concernant la création d’une 
« géodatabase », d’un  « jeu de classes d’entités » et d’une « classe d’entités », pour suivre 
directement les indications de la section « Créer un nouveau « Shapefile » (ArcCatalog) » à la 
page 52. 
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Pour créer un nouveau fichier de données géographiques, deux possibilités s’offrent à 
vous : 

 Soit, exporter ou copier un fichier ou une partie de fichier existant vers un nouveau 
fichier, dans ArcMap ou ArcCatalog  (ne pas utiliser cette possibilité dans le cas de 
l’exercice « Philippines ») 

 Soit, créer un nouveau fichier « vide » dans ArcCatalog et l’éditer (ou construire) 
dans ArcMap. Lors de la création d’un nouveau fichier indépendant d’un fichier 
existant, VOUS DEVEZ TOUJOURS D’ABORD CREER UN FICHIER VIDE DANS 
ARCCATALOG (voir ci-dessous) et ENSUITE L’EDITER (le remplir) DANS ARCMAP 
(voir ci-dessus). 

 

Créer une nouvelle géodatabase (ArcCatalog) 
Une « geodatabase » est une structure hiérarchique (illustration ci-joint) reprenant un 
ensemble de jeux de données géographiques dans ArcGIS. Ces jeux de données peuvent être 
de différents types : jeu de classes d’entités (« feature dataset »), classes d’entités  
(« feature classes »), « attribute tables », et bien d’autres.  
 
Pour créer une nouvelle géodatabase : 

 Ouvrez ArcCatalog en cliquant sur le bouton de raccourcis 

  dans ArcMap. 

 Naviguez jusqu’au répertoire dans lequel vous désirez créer votre nouvelle 
géodatabase,  

 Cliquez-droit sur le dossier dans laquelle vous voulez créer votre géodatabase, 

 Choisissez « New > Personal Geodatabase » pour créer une nouvelle géodatabase 

 Cliquez-droit sur le nom de la géodatabase et choisissez « Rename » pour la 
renommer en « Geodatabase Votre NOM » 

 

!! Remarquez que lors de la création d’un nouveau fichier (ou d’une nouvelle table), les noms 
comprenant des caractères spéciaux, des espaces ou plus de 13 caractères sont à proscrire : 
bien que compatibles avec certaines fonctions de bases, ils sont incompatibles avec les 
options avancées. Comme pour tout fichier informatique, pensez néanmoins à donner des 
noms le plus explicite possible. 

 

Créer un nouveau « Jeu de classes d’entités » dans une géodatabase 
(ArcCatalog) 
Un « jeu de classes d’entités » est, dans ArcGIS, une structure hiérarchique reprenant un 
ensemble de classes d’entités (« feature classes”) pouvant être de types différents (points, 
linges, polygones) et qui partagent une même référence spatiale (même système de 
coordonnées). 
 
Pour créer un nouveau « jeu de classes d’entités » : 

 Cliquez-droit sur le nom de la géodatabase et choisissez « New > Feature Dataset… » 
pour insérer un nouveau jeu de classe d’entités dans votre géodatabase 

 Nommez votre « nouveau jeu de classe d’entités » dans la fenêtre « New feature 
Dataset > Name : » qui apparait 

 Cliquez sur « Suivant » 
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 Choisissez le système de coordonnées de votre « jeu de classes d’entités”  

 Cliquez sur « Suivant » 

 (Choisissez ou pas un système de coordonnées pour les données « Z ») 

 Cliquez sur « Suivant » 

 Choisissez la résolution par défaut : 
o une « XY Tolerance » de 0.001 mètre par exemple donnera une précision du plan 

XY du système de coordonnées de 1 mm ;  
o une « Z Tolerance » de 0.001 mètre par exemple donnera une précision de 

l’élévation (altitude ou profondeur) du système de coordonnées de 1 mm,  
o (une « M Tolerance » de 0.001 ).  

 Cliquez sur « Finish » 
 

Créer une nouvelle « Classe d’entités » dans un « Jeu de classes d’entités » 
(ArcCatalog) 
Une « classe d’entités » est, dans ArcGIS, un ensemble d’entités spatiales (une entité spatiale 
correspond à un objet du monde réel tel que représenté sur une carte) présentant le même 
type de géométrie (points ou linges ou  polygones) et qui partagent une même référence 
spatiale (même système de coordonnées) et les mêmes attributs. 
 
Pour créer une nouvelle « classe d’entités » : 

 Cliquez-droit sur le nom de votre nouveau jeu de classes d’entités « New Feature 
Dataset » et choisissez « New > Feature Class… » pour insérer une nouvelle class 
d’entités dans votre « jeu de classes d’entités ». 

 Nommez-la dans « Name : » 

 Choisissez le type d’entités que vous voulez créer, (polygons, lines, points, etc) 

 Cliquez sur « Suivant » 
L’interface qui apparait vous permet de construire la table d’attribut du fichier vectoriel que 
vous créez en spécifiant les champs (colonne de la table) et leur type (format, etc). 2 champs 
indispensables existent par défaut : 

 « Objectid », l’identifiant unique de chaque ligne dans une table 

 « SHAPE » définissant le type de géométrie de vos entités. 

 Ajoutez un nouveau champ dans votre table d’attribut en construction :  

 Nommez votre nouveau champ en cliquant sur une case blanche vide de la colonne 
« Field Name » et nommez-le 

 Choisissez le type de donnée que ce sera dans la colonne « Data Type » (Text, Date, 
Double, etc).  

 Précisez les paramètres affairant au « Data Type » choisi (longueur, décimalité, etc). 

 Cliquez sur le bouton « Finish » 
 

Créer un nouveau « Shapefile » (ArcCatalog) 
Un shapefile est un fichier de données vectorielles (points ou lignes ou polygones) 
enregistrant la localisation, la forme, les attributs etc. des entités géographiques.  
 
Pour créer un shapefile : 

 Cliquez-droit sur le dossier dans laquelle vous voulez insérer le nouveau shapefile 

 Choisissez « New > Shapefile… » 
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 Nommez-le dans l’encadré « Name : » 

 Choisissez le type d’entité (« Feature Type : ») que ce shapefile représentera 

 Sélectionnez le système de coordonnées dans l’encadré « Spatial Reference » en 
cliquant sur le bouton « Edit …» 
o Soit, sélectionnez le système de coordonnées avec le bouton « Select » 
o Soit, importez le système de coordonnées à partir d’un fichier ayant le système 

de coordonnées que vous voulez utiliser, en cliquant sur « Import ». Naviguez 
ensuite jusqu’à ce fichier, sélectionnez le, cliquez « Add », cliquez « OK » 

 Cliquez « OK »  
 
Remarquez qu’un fichier « Jeu de classes d’entités » ou « Shapefile » ne peut contenir des 
données que d’un seul type de géométrie : point OU ligne OU polygone OU… 
 
Pour modifier certaines propriétés de votre nouvelle « Classe d’entités » ou nouveau 
« Shapefile », cliquez-droit sur le fichier dans ArcCatalog et allez dans « Properties… ». Vous 
pouvez notamment ajouter des champs via l’onglet « Fields ».  
 
Les fichiers créés de la sorte dans ArcCatalog sont « vides » (ne contient aucune entité 
spatiale). Pour « remplir » ou «éditer » ces fichiers, vous devrez (confer la section 3.3.18.1 ci-
dessus) : 

 retourner dans ArcMap,  

 ajouter ces fichiers dans votre projet ArcMap et  

 ouvrir une session d’édition sur les fichiers à éditer. 
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Contextualisation 5  
Etude de l’évolution spatiale des zones écologiques 

du Guatemala 
 
Le centre d’étude en écologie du Guatemala vous demande de réaliser une  
étude de l’évolution des zones écologiques du Guatemala depuis 1950 jusqu’à 
 maintenant. La première étape de votre travail consiste en la collection des 
données historiques disponibles.  
 
 
 
 
 
 
Au cours de vos recherches vous avez trouvé la carte « Mapa ecologico de Guatemala, con la 
clave de clasificacion de vegetales del mundo » datant de 1959 sur le site web du 
« European archive on the soil maps of the WORLD (EuDASM) » 
(http://eusoils.jrc.ec.europa.eu/esdb_archive/eudasm/EUDASM.htm). Cette carte n’était 
disponible que dans un format JPG non géoréférencée. Vous l’avez téléchargée dans le 
dossier «…\Initiation ArcGIS SIG ACE\DATA\6 Georeferencing\» sous le nom 
« guat_lucp.jpg ». 
 
Afin de pouvoir facilement comparer cette carte avec les autres données plus récentes, que 
vous récolterez ultérieurement, vous devez importer cette carte dans ArcGIS et la 
géoréférencer. Vous travaillerez dans le projet ArcMap « …\DATA\6 
Georeferencing\Georeferencing in Guatemala.mxd ». 
 
Les indications ci-dessous (section 3.3.19) devraient vous permettre de réaliser ces 
différentes tâches. Le système de coordonnées utilisé pour réaliser cette carte n’y est 
malheureusement pas indiqué. Vous supposerez dès lors que le système utilisé est le système 
« Predifined \Geographic Coordinate Systems \World\WGS 1984 ». Vous géoréférencerez 
cette carte par rapport aux frontières du Guatemala disponibles dans le fichier 
« countries.shp ». 
 
Contextualisation 5 : Etude de l’évolution des zones écologiques du Guatemala. 

3.3.19. Géoréférencement. 

Le géoréférencement est utile pour positionner correctement dans l’espace un fichier, de 
type raster, non géoréférencé, par exemple une carte papier ou une image aérienne. Notez 
que cette opération s’intègre souvent dans la  séquence d’opérations suivante : 

 Obtention d’une carte papier sur une zone d’étude  
 Digitalisation de la carte papier via scannage et obtention de la carte en format 

numérique, JPG par exemple 
 Importation du fichier JPG dans ArcGIS 

http://eusoils.jrc.ec.europa.eu/esdb_archive/eudasm/EUDASM.htm
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 Géoréférencement de la carte JPG dans un format « .tif » par exemple comprenant 
un positionnement dans l’espace et un système de coordonnées.  

 Vectorialisation de la carte par création d’un shapefile reprenant les entités spatiales 
de la cartes (routes, sources, etc) (Confer section 3.3.18) 

 Edition des attributs du shapefile (type de route, débit des sources, etc) (Confer 
section 3.3.18) 

 Obtention d’une carte digitale vectorielle géoréférencée. 

 
Pour géoréférencer un fichier, 

 Ouvrez un projet ArcMap. 

 Système de coordonnées !  (1/2) 
o Identifiez le système de coordonnées dans lequel est exprimée la carte à 

géoréférencer. Cette information est en principe toujours présente sur une 
carte. Si elle est absente, à vous de faire la meilleure supposition.  

o Dans ArcMap, attribuez ce système de coordonnées au bloc de données (en 
haut de la table des matières de votre projet ArcMap) qui contient le fichier à 
géoréférencer. Dans les versions d’ArcGIS 10 et suivantes, ce système de 
coordonnées du bloc de données sera automatiquement attribué à la couche 
à géoréférencer  lors de l’opération « Rectify » décrite plus loin ci-dessous. 

 Référence ! Le géoréférencement doit se faire par rapport à une référence spatiale. 
Deux possibilités existent : 

o Utiliser une donnée de référence déjà géoréférencée, visible également sur 
l’image à géoréférencer, par exemple des limites administratives. La suite de 
la procédure décrite ci-dessous concerne ce cas-ci. 

o Utiliser les coordonnées présentes sur l’image à géoréférencer (si c’est une 
carte par exemple, elle comprendra surement une grille de coordonnées 
géographiques) et les comparer aux coordonnées de votre interface ArcMap 
dont vous choisirez les unités pour les faire correspondre aux unités utilisées 
dans la carte (confer section 3.3.10). 

 Ajoutez dans ArcMap le fichier de référence par rapport auquel vous voulez 
géoréférencer votre image, par exemple une carte déjà géoréférencée, un fichier 
vectoriel de limites administratives, de cours d’eau ou de points GPS…  

 Ajoutez dans ArcMap le fichier numérique contenant les données que vous voulez 
géo-référencer  
o Lors de l’ajout de ce fichier, répondez « non » lorsqu’une fenêtre vous demande 

si vous voulez créer des « pyramids » 
o Ce fichier s’affiche dans votre table des matières et, n’ayant pas de référence 

spatiale, s’affiche de manière arbitraire dans votre interface ArcMap.  

 Pour visualiser votre fichier à géoréférencer : 
o Cliquez-droit sur le nom de la couche et choisissez « Zoom To Layer ». 

 Cliquez éventuellement sur  pou vous rendre compte du non géoréférencement 
du fichier. 

 Zoomez sur la zone de votre fichier de référence correspondant à l’étendue 
approximative du fichier à géoréférencer. 

 Si votre fichier de référence est de type vectoriel, placez-le au-dessus du fichier à 
géoréférencer dans la table des matières d’ArcMap afin que ce dernier ne soit pas 
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caché. Si votre fichier de référence est de type « polygones », choisissez une 
symbologie avec fond transparent et bordures bien visibles (Cf. ci-dessous et la 
section  « 3.3.24.2 Symbologie des données. » à la page 77 pour plus d’information 
sur la symbologie des fichiers). 

o Dans la table des matières, double cliquez sur le symbole de la couche de 
référence de type « polygon » et choisissez « No Color », dans l’encadré 
« Options > Fill Color »,  et  la couleur rouge comme « Outline Color », la 
fenêtre « Symbol Selector ». Et cliquez « OK ». Vous pourrez de la sorte voir 
votre fichier à géoréférencer à travers la couche « polygon » clairement 
visible. 

 Faites apparaitre la barre d’outils de géoréférencement (« Georeferencing », 
illustration ci-dessous) dans ArcMap à l’aide de l’onglet « Tools » de la barre de menu 
principale d’ArcMap : 
o Cliquez sur « Tools >  “Customize”… > onglet « Toolbars » > cochez la case 

« Georeferencing » > Close ».  

 
 Dans le menu déroulant de la barre d’outils « Georeferencing », sélectionnez le 

fichier à géoréférencer pour que les opérations que vous réaliserez avec cet outil 
agissent sur ce fichier. 

 Dans le menu déroulant « Georeferencing » (flèche noire vers le bas), cliquez sur « Fit 
To Display ». Votre fichier à géoréférencer  s’ajuste à la fenêtre de visualisation 
actuelle. 

 Système de coordonnées !  (2/2) (opération à faire uniquement pour les versions 
d’ArcGIS antérieure à ArcGIS 10) 

o Dans ArcMap, à l’aide de la fonction « Define » disponible dans l’ArcToolbox, 
définissez le système de coordonnées du fichier à géoréférencer (cf. Note 3 : 

De la gestion des systèmes de coordonnées des fichiers à la page 27) 
o Si l’image à géoréférencer a bougé après l’utilisation de la fonction « Define », 

recliquez sur « Fit To Display » pour réajuster l’image. 

 Cliquez sur le bouton de la « table des liens » ou « table des points de contrôles » 

. Cette table reprend les points de contrôle que vous allez créer, avec leurs 
coordonnées XY « Source » et « Map » ainsi que, à partir du quatrième point, l’erreur 
résiduel commise pour chaque point et l’erreur quadratique moyenne du 
géoréférencement total (« RMSError – Root Mean Square Error ») vous indiquant la 
cohérence/précision de votre géoréférencement. 

  « Zoomez » à l’aide de l’outil  (tracer un cadre de sélection) sur une zone 
présentant une même caractéristique de forme, bien identifiable à la fois sur la 
couche de référence et sur la couche à géoréférencer, par exemple, un angle d’une 
limite administrative. Au plus votre zoom sera important au plus la précision de votre 
géoréférencement sera grande, celle-ci étant toutefois limitée à la précision des 
données de référence et à géoréférencer (échelle, simplification des contours, 
épaisseur des traits sur une carte,…)  

 Cliquez sur le bouton d’ajout de points de contrôle , puis avec cet outil, cliquez 
sur le point identifié ci-dessus du fichier à géoréférencer ou « source », puis cliquez 
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sur le point correspondant sur le fichier de référence ou « cible » (« target ») déjà 
géoréférencé) afin de déplacer le point à géoréférencer vers sa position de référence. 

 Faites de même (Attention : dans le sens « Source vers Cible » !!) pour quelques 
autres points jusqu’à ce que votre résultat vous satisfasse. N’hésitez pas utiliser les 
outils de Zoom pour améliorer votre précision pendant une procédure d’ajout  d’un 
point de contrôle, par exemple : 

o Zoomez ( …) sur votre point de contrôle « source » sur la couche à 
géoréférencer 

o Cliquez sur   et placez votre point de contrôle « source » sur la couche à 
géoréférencer 

o Zoomez ( …) sur votre point de contrôle « cible » sur la couche de référence 

o Cliquez  sur  et placez votre point de contrôle « cible » sur la couche de 
référence 

 
Vérifiez également les résidus de chaque point et le RMSE dans la « table des points de 
contrôles » que vous pouvez éventuellement enregistrer. 
Vous pouvez supprimer un point de contrôle présentant un résidu trop grand : sélectionnez-

le et cliquez sur le bouton de suppression de la table . 
 
Lorsque vous estimez le géoréférencement correct, vous devez encore « Rectifier » votre 
carte des sols pour l’enregistrer dans sa nouvelle position. Si vous oubliez cette étape,  vos 
opérations précédentes n’auront servi à rien. 

 Cliquez sur « Georeferencing > Rectify… » 

 Dans la fenêtre qui s’ouvre « Save As », indiquez les paramètres adéquat, dans ce 
cas-ci : « Cell Size » par défaut, « Resample Type » Nearest Neighbor (for discrete 
data) (ré-échantillonnage par la méthode du plus proche voisin), votre « Output 
Location » où vous allez enregistrer votre fichier géoréférencé, le « Name » du 
fichier : et le « Format » de l’image : Tif, par exemple 

 Cliquez « Save » 
La « rectification » peu prendre un certain temps. 

 Ajoutez votre fichier rectifié dans votre projet ArcMap et vérifiez que le 
géoréférencement s’est fait correctement. 

 Sauvez puis supprimez les points de contrôle de l’interface d’ArcMap avec le menu 
déroulant de l’outil « Georeferencing ». 

 
Pour mieux comprendre les concepts de géoréférencement (RMSE, types de ré-
échantillonnage, etc), tapez « georeferencing » dans l’index de « ArcGIS Desktop Help » et 
consultez les différentes rubriques présentées. 
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Contextualisation 6  
Evaluation du nombre de personnes potentiellement  

Impactées par une catastrophe nucléaire en Inde 
 
Le ministère de la santé indien aimerait évaluer le nombre de personnes approximatif 
potentiellement impactées suite à une catastrophe nucléaire majeure dans  chacun de leurs 
7 sites nucléaires potentiellement dangereux. Le scénario retenu est celui d’une catastrophe 
similaire à celle de Fukushima où le rayon de contamination radioactive était de l’ordre de 
100 km. 
 
 
 
 
 
 
Pour ce faire vous disposez, dans le dossier «…\DATA\7 Geoprocessing », des données 
suivantes : 

 « NuclearReactors2011.shp », reprenant l’ensemble des centrales nucléaires du 
monde. La colonne « Plant» reprend le nom des centrales. 

 « India_population_per_district.shp », reprenant la démographie indienne par 
district  dans la colonne « Pop » (avec des « 0 » pour les districts pour lesquels 
l’information est manquante). 

 
La démarche à suivre pour réaliser cette étude à l’aide d’un SIG est la suivante : 

1. Créer un fichier de zones tampons  (« buffer ») de 100 km à partir du shapefile 
« NuclearReactors2011.shp », que vous appellerez 
«NuclearReactors2011_Buffer_100km.shp ». Les paramètres de la fonction 
« Buffer » à utiliser sont : buffer de type «linear unit » de 100 km. Les autres 
paramètres sont à laisser par défaut. 

2. Réaliser une « intersection » (« Intersect ») entre le fichier des zones tampons autour 
des centrales et celui de la population indienne par district que vous appellerez 
«Nuclear_Buffer_100km_inter_pop.shp ». Les autres paramètres sont à laisser par 
défaut.   

3. Simplifier le fichier «Nuclear_Buffer_100km_inter_pop.shp » afin que celui-ci ne 
contienne plus, dans chaque zone tampon (c’est-à-dire, pour chaque centrale),  qu’un 
seul enregistrement (une seule ligne de la table d’attribut) par district, afin de ne pas 
comptabiliser deux fois le même district dans le calcul de la population affectée. En 
effet, l’opération d’intersection a parfois segmenté les districts se trouvant à la limite 
des zones tampon en plusieurs entités spatiales distinctes (confer l’illustration ci-
dessous pour les Districts de Valsad, pour les centrales de Kakrapar et Tarapur). 
Cette simplification se fera à l’aide de la fonction « Dissolve » à partir du fichier 
«Nuclear_Buffer_100km_inter_pop.shp » en choisissant comme paramètres : 
« Dissolve fields », cochez les colonnes « Plant » et « District» ; « Statistics Fields » : 
les « Fields » « Pop» , « Plant » et « District » avec la « Statistic Type » « First » 
(conservation de la première valeur rencontrée dans la table par combinaison 
« centrale-district »). La simplification se fait donc par combinaison unique de «Plant-
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District » : 

  « District » car certains Districts sont segmentés en plusieurs entités spatiales 
par les zones tampons 

  « Plant » pour comptabiliser pour chaque centrale indépendamment un 
District qui se trouve dans les zones tampons de plusieurs centrales. 

 Le fichier résultant de l’opération s’appellera 
«Nuclear_Buffer_100km_inter_pop_disso.shp » 
 

 
4. Calculer la somme des personnes impactées par centrale nucléaire à partir de la 

table d’attribut du fichier «Nuclear_Buffer_100km_inter_pop_disso.shp », à l’aide de 
la fonction « Summarize » présentée plus haut à la section 3.3.17.1 en la 
paramétrant comme suit : 1) « Select field to summarize » : « Plant » ; 2) Statistics : 
«Sum » de « First pop » ; 3) fichier de résultat (« Somme des populations des districts 
compris dans un rayon de 100 km autour de chacune des centrales »). 

 
Les indications ci-dessous (section 3.3.20) vous aideront à réaliser cette étude. Vous 
travaillerez dans le dossier «…\DATA\7 Geoprocessing ». 
Contextualisation 6 : Evaluation du nombre de personnes potentiellement impactées par une 
catastrophe nucléaire en Inde. 

3.3.20. Utiliser l’assistant de géotraitement.  

Le géotraitement peut se définir comme étant la manipulation de données géographiques 
dans le but de produire de nouvelles informations. 
Les opérations de géotraitement s’effectuent via des outils SIG, organisés en « boites à 

outils » (« Toolboxes ») dans « ArcToolbox » . 
 
Pour ouvrir ArcToolbox, 

 Cliquez sur l’icône « ArcToolbox »  dans la barre d’outils « Standard » d’ArcMap. 
Pour chercher un outil dans « ArcToolbox » : 
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 Utilisez l’onglet « Favorites » pour les chercher par thème ou 

 Utilisez l’onglet « Index » si vous connaissez le nom de l’outil à utiliser 

 Utilisez l’onglet « Search » pour chercher un outil par mot clef 
 
Dans la cadre de ce TP, 3 outils seront utilisés: 

 « Buffer » : crée une zone tampon à partir d’un fichier vectoriel  

 « Intersect » : intersecte 2 couches de données géographiques 

  « Dissolve » : agrège des entités spatiales sur base d’un ou plusieurs attributs de la 
table d’attributs.  

 
En Annexe 2,  un tableau reprend, illustre et explique brièvement quelques outils 
fréquemment utilisés dans ArcToolbox. 

3.3.20.1. Créer une Zone Tampon : outil « Buffer » 

Pour créer une zone tampon,  

 Cliquez sur l’icône « ArcToolbox »  dans la barre d’outils « Standard » d’ArcMap si 
ArcToolbox n’est pas encore ouvert 

 Doublez-cliquez sur l’outil de création de zones tampons. Pour trouver cet outil : 
o Soit, utilisez l’onglet  « Favourites » et suivez le chemin suivant : « ArcToolbox > 

Analysis Tools > Proximity > Buffer », et double-cliquez sur « Buffer » 
o Soit,  utilisez l’onglet « Index », et tapez « Buffer », et double-cliquez sur « Buffer 

(analysis) » 
L’assistant de création d’une zone tampon s’ouvre 

o Dans le menu déroulant « Input Features », faites apparaître à l’aide de la flèche 
noire les couches disponibles dans votre table des matières et sélectionnez le 
fichier à partir duquel vous allez créer une zone tampon 

o Dans l’encadré « Output Feature Class », naviguez jusqu’au répertoire où vous 
souhaitez enregistrer votre fichier contenant les zones tampons que vous allez 
créer et nommez. 

o Dans l’encadré « Distance [Value or field] », choisissez si vous voulez indiquer 
vous-même la largeur (« Linear Unit ») ou si vous voulez utiliser un champ de la 
table d’attributs (« Field ») pour définir la largeur de la zone tampon. 

o Choisissez le type de buffer qui  vous convient le mieux. 
o Utiliser un « Dissolve Field(s) » pour fusionner les « buffers » créés à partir 

d’entités spatiales différentes mais partageant un même attribut (par exemple : 
plusieurs segments (lignes) appartenant à la même rivière). 

o Cliquez « OK » 
Le fichier de la zone tampon créé s’affiche dans ArcMap. 

3.3.20.2. Intersecter 2 couches de données géographiques : outil 
« Intersect ». 

Pour réaliser une intersection entre 2 couches, 

 Cliquez sur l’icône « ArcToolbox »  dans la barre d’outils « Standard » d’ArcMap si 
ArcToolbox n’est pas encore ouvert 
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 Double-cliquez sur l’outil d’intersection « Intersect ». Pour trouver cet outil : 
o Soit, utilisez l’onglet  « Favourites » et suivez le chemin suivant : « ArcToolbox > 

Analysis Tools > Overlay > Intersect », et double-cliquez sur « Intersect » 
o Soit,  utilisez l’onglet « Index », et tapez « Intersect », et double-cliquez sur 

« Intersect (analysis) » 
L’assistant d’intersection s’ouvre 

 Dans le menu déroulant « Input Features », faites apparaître à l’aide de la flèche 
noire les couches disponibles dans votre table des matières et sélectionnez 
successivement les fichiers à intersecter. (Patientez quelque peu après avoir 
sélectionné chacun des 2 fichiers, l’ajout des fichiers dans la colonne « Features » 
peut prendre un peu de temps). 

 Dans l’encadré « Output Feature Class », naviguez jusqu’au répertoire où vous 
souhaitez enregistrer votre fichier d’intersection et nommez le. 

 Vous pouvez laisser les autres paramètres par défaut. 

 Cliquez « OK » 
Le fichier de zones tampons créé s’affiche dans ArcMap. 

3.3.20.3. Agréger des entités spatiales sur base de la table d’attribut: 
outil « Dissolve ». 

Pour réaliser une agrégation d’entités spatiales  sur base de la table d’attribut : 

 Cliquez sur l’icône « ArcToolbox »  dans la barre d’outils « Standard » d’ArcMap si 
ArcToolbox n’est pas encore ouvert 

 Double-cliquez sur l’outil d’intersection « Intersect ». Pour trouver cet outil : 
o Soit, utilisez l’onglet  « Favourites » et suivez le chemin suivant : « ArcToolbox > 

Data Management Tools > Generalization », et double-cliquez sur « Dissolve » 
o Soit,  utilisez l’onglet « Index », et tapez « Dissolve », et double-cliquez sur 

« Dissolve (management) » 
L’assistant d’agrégation s’ouvre 

 Dans le menu déroulant « Input Features », faites apparaître à l’aide de la flèche 
noire les couches disponibles dans votre table des matières et sélectionnez le fichier 
sur lequel vous voulez réaliser une agrégation. 

 Dans la fenêtre « Dissolve Field(s) (optional), cochez les colonnes par lesquelles vous 
voulez réaliser l’agrégation 

 Dans la fenêtre  « Statistics Field(s) (optional) », sélectionnez les colonnes pour 
lesquelles vous voulez calculer une statistique et choisissez le type de statistique à 
calculer via le menu « Statistic Type »  

 Dans l’encadré « Output Feature Class », naviguez jusqu’au répertoire où vous 
souhaitez enregistrer votre fichier d’agrégation et nommez le. 

 Cliquez « OK » 
Le fichier agrégé créé s’affiche dans ArcMap. 
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Contextualisation 7  
Evaluation de la susceptibilité aux glissements de terrain en 

cas de déforestation d’un territoire de forêt brésilienne. 
 
« Green Planet », ONG luttant pour la préservation de la forêt brésilienne, a été alertée d’un 
projet de déforestation massive dans la zone de « Paraisoverde ». En plus de leur 
communication habituelle face à ce genre de situation, et étant donné que la zone est 
relativement accidentée, elle aimerait, afin de sensibiliser d’avantage l’opinion publique à la 
catastrophe écologique qui s’annonce, réaliser une carte de susceptibilité au glissement de 
terrain en cas de déforestation de « Paraisoverde ».  
 
 
 
 
 
 
Pour ce faire vous disposez, dans le dossier «…\DATA\8 Spatial Analyst », de quelques 
données, peu détaillées, les seules disponibles sur la zone : 

 « ASTGTM2_S09W056_dem_clip_m.tif » un Modèle Numérique de Terrain (MNT) de 
la zone avec une résolution spatiale horizontale de 30 m * 30 m 

 «Rivers.shp », un shapefile approximatif du réseau hydrographique de  
« Paraisoverde ». 

 « Rivers», un raster (format « ESRI GRID ») établissant la proximité du réseau 
hydrographique. Les cellules de ce raster ont une valeur de : 

o  « 2 » lorsqu’elles sont à une distance inférieure à 400 mètres du réseau 
hydrographie 

o « 1 » dans le cas contraire 

 « Soil survey.shp », un shapefile de points correspondant à un échantillonnage de sol, 
localisés par GPS, et  établissant le type de sol et sa susceptibilité aux glissements de 
terrain. 3 types de sols ont été identifiés (voir la table d’attribut du shapefile): 

1. « Très susceptible », code « 1 » (« High susceptibility ») 
2. « Moyennement  susceptible », code  « 2 » (« Medium susceptibility ») 
3. « Pas susceptible », code « 3 » (« No susceptibility ») 

 « Soil_survey_Google_Earth_KMZ.kmz », le fichier « Soil survey.shp » transformé en 
format compatible avec Google Earth. 

 
Vous travaillerez dans le dossier «…\DATA\8 Spatial Analyst » avec le projet ArcMap « Spatial 
Analyst Landslide Model.mxd ». 
 
A l’aide de ces données vous allez réaliser un modèle SIG exprimant la susceptibilité de la 
zone aux glissements de terrain. L’idée est de réaliser une somme pondérée des différents 
paramètres intervenant dans le processus des glissements de terrain :  

 La pente (plus la pente est forte, plus la susceptibilité sera grande), 

 Le type de sol (susceptibilité plus ou moins grande selon le type de sol), 

 La proximité des rivières (les rivières, en cas de crues, peuvent contribuer à la 
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déstabilisation des pentes voisines), 
 La démarche à suivre est la suivante (Figure 14) : 

1. Explorez vos données, spatialement et via les tables d’attributs à l’aide du projet 
ArcMap «…\DATA\8 Spatial Analyst\Spatial Analyst Landslide Model.mxd ». Vous 
pouvez également explorer la zone à travers Google Earth en  

1. Installant Google Earth sur votre machine, disponible ici : 
http://www.google.fr/intl/fr/earth/index.html 

2. Cliquant sur le fichier « Soil_survey_Google_Earth_KMZ.kmz », ce qui vous 
amènera directement sur la zone d’étude dans Google Earth. 

3. Utiliser une vue dans le plan horizontal dans Google Earth et définir une 
exagération du relief par 3 afin de faciliter sa visualisation an allant dans 
« Outils / Option / Vue 3D / Relief / Facteur d’élévation = 3 » 

 

 
Figure 14 : Schéma des opérations à réaliser avec « Spatial Analyst » pour la création d’un raster 
exprimant la susceptibilité aux glissements de terrain. 

 
2. Interpolation spatiale des données relatives au type de sol. Le but de cette opération 

est d’obtenir une couche « raster » avec une information relative au type de sol en 
tous points de la zone à modéliser. Réalisez cette opération à l’aide de l’outil 
« Interpolate to Raster » de « Spatial Analyst », décrit ci-dessous (Cf. section 3.3.21, 
3.3.21.1 et 3.3.21.2), avec la méthode « Inverse Distance Weighted » (IDW), à partir 
du fichier « Soil survey.shp », avec comme « Z value field », le champ « Code », en 
nommant le fichier résultat « Soil » dans le format « ESRI GRID », et en laissant les 
autres paramètres par défaut. Modifiez éventuellement la symbologie (cf. section 
3.3.24.2) de ce raster afin de faire ressortir les 3 classes de sols (symbologie 
« Classified », avec 3 classes dont les bornes supérieures sont : 1.5 ; 2.5 et 3). 

3. Création d’un raster de pentes à partir du MNT. Réalisez cette opération à l’aide de 
l’outil  « Slope » de « Spatial Analyst »,  présenté ci-dessous (Cf. section 3.3.21.3), en 

http://www.google.fr/intl/fr/earth/index.html
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choisissant  comme « Input surface » le MNT, comme « Output measurement » : 
« Degree», en nommant le fichier résultat « Slope », et en choisissant le format « ESRI 
GRID ». Les autres paramètres gardent leur valeur par défaut. Remarquez que le MNT 
utilisé est projeté dans un système de coordonnées utilisant des mètres comme unité 
linéaire en XY (« WGS_1984_UTM_Zone_21S ») et que l’altitude est également 
exprimée en mètres, ce qui permet d’utiliser un « Z factor »  égale à 1 (Cf. ci-dessous). 
Modifiez éventuellement la symbologie (cf. section 3.3.24.2) de ce raster afin de faire 
ressortir les 4 classes de pentes identifiées dans le tableau ci-dessous (symbologie 
« Classified », avec 4 classes).Posez-vous la question de la correspondance entre les 
couleurs et les classes de pentes du fichier résultat et identifiez les zones de fortes et 
de faibles pentes. 

A ce stade vous disposez des 3 « rasters bruts » à intégrer dans le modèle (Slope, Soil, 
Rivers).  

4. Reclassification des valeurs des paramètres en classes de valeurs exprimant leur 
susceptibilité au glissement de terrain sur une échelle [0-10] (ce doit être des nombres 
entiers à cause du format « ESRI GRID » des rasters). Il existe de nombreuses 
méthodes de conversion des « valeurs-paramètres » vers les « valeurs-susceptibilité 
au glissement de terrain » et le choix d’une méthode en particulier devrait être 
déterminé sur base d’une étude poussée, ce qui ne pourra se faire dans le cadre de cet 
exercice. Vous appliquerez donc « arbitrairement » les règles de reclassification 
suivantes pour l’exercice : 

Pentes Types de sol Proximité aux rivières 

Pentes en 
degrés 

Susceptibilité 
[0-10] 

Code sol 
Susceptibilité 

[0-10] 
Code 

proximité 
Susceptibilité 

[0-10] 

0-10 0 1 – 1.5 10 1 0 

10-20 3 1.5 – 2.5  5 2 10 

20-30 7 2.5 – 3 2   

30-70 10     

Cette opération se fait avec l’outil de « Spatial Analyst » « Reclassify », présenté ci-
dessous (Cf. section 3.3.21.4). Réalisez 3 « reclassifications » pour chacun des 3 
rasters et nommez les rasters résultants : « SlopeR », « SoilR », « RiversR ». 

 
5. Intégration des 3 rasters reclassifiés pour produire un raster exprimant la 

susceptibilité aux glissements de terrain. Cette opération se fait via l’outil « Raster 
Calculator » de « Spatial Analyst », dont le fonctionnement est décrit ci-dessous (Cf. 
section 3.3.21.5). La formule mathématique permettant la combinaison des 3 rasters 
devrait être justifiée sur base d’une calibration, une revue de littérature ou autre, ce 
qui n’est pas fait dans le cadre de cet exercice. Vous utiliserez la simple formule 
suivante qui donne une importance légèrement plus grande au paramètre 
« Pentes » : 

0.4 * [SlopeR] + 0.3 * [SoilR] + 0.3 * [RiversR] 
Répondez «Oui » à l’éventuel message d’avertissement apparaissant au moment de 
l’évaluation de la formule. Le fichier exprimant la susceptibilité aux glissements de 
terrain est créé. Modifiez éventuellement la symbologie (cf. section 3.3.24.2) de ce 
raster afin que la représentation soit jolie et parlante (symbologie « Streched » avec 
une rampe de couleurs adéquate). 
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Les indications ci-dessous vous aideront à réaliser cette étude. 
 

Contextualisation 7 : Evaluation de la susceptibilité aux glissements de terrain en cas de 
déforestation d’un territoire de forêt brésilienne 

3.3.21. Utiliser une extension d’ArcGIS – « Spatial Analyst » 

L’extension « Spatial Analyst » permet de travailler (analyser, créer, réaliser des requêtes) 
sur des données de type « raster » (ou « matricielle », constituées d’une grille de cellules), 
éventuellement intégrée avec des données vectorielles (points, lignes, polygones). 

3.3.21.1. Activer et afficher une extension d’ArcGIS. 

Avant de pouvoir utiliser une extension dans ArcGis, en plus d’avoir la licence donnant droit 
à son utilisation, il faut l’activer. 
 
Pour activer l’extension « Spatial Analyst »,  

 Cliquez sur « Tools > Extensions… » dans la barre de menu d’ArcMAP. 

 Cochez le carré blanc à gauche de « Spatial Analyst » pour activer cette extension 

 Cliquez « Close » 
Si l’extension n’est pas activées, certaines opérations de l’outil « Spatial Analyst » ne seront 
pas accessibles. 
 
Pour afficher la barre d’outils « Spatial Analyst », 

 Cliquez sur « View > Toolbars > Spatial Analyst » dans la barre de menu d’ArcMAP. 
 
Remarquez que les fonctions disponibles via le menu « Spatial Analyst » le sont également 
via « Arc Toolbox ». L’utilisation des fonctions via « Arc Toolbox » présente cependant 
l’avantage de fournir un descriptif des paramètres à rentrer dans la fonction. 

3.3.21.2. Interpolation spatiale 

Pour réaliser une interpolation spatiale à l’aide de l’extension « Spatial Analyst » : 

 Cliquez sur « Spatial Analyst > Interpolate to Raster > … » 
3 méthodes d’interpolation spatiale s’offrent gracieusement à vous :  

o « Inverse Distance Weighted… » : pondération inverse à la distance 
o « Spline… » 
o « Kriging… » : krigeage  

 Choisissez comme « Input points : » le fichier shapefile de points contenant les 
valeurs que vous désirez interpoller. 

 Choisissez comme « Z value field » le champ de ce fichier qui contient le paramètre à 
interpoler. 

 Choisissez comme « Output cell size : » la taille de cellule que vous désirez pour votre 
raster résultat (selon la précision nécessaire) 

 Enregistrez votre « Output raster : » dans le répertoire de travail et nommez votre 
raster interpolé. Attention, le type « ESRI GRID », tolère un nom de maximum 13 
caractères.  
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 Les autres paramètres sont à laisser par défaut ou à modifier selon vos souhaits sur 
base d’une connaissance précise de leurs effets sur l’interpolation (cf. remarque ci-
dessous). 

 Cliquez « OK » 
Votre raster d’élévation interpolée s’affiche dans ArcMap. 
 
Remarques : 

1. Il n’existe pas de « recette » pour le choix de la meilleure méthode d’interpolation 
et du meilleur paramétrage étant donné la diversité de choix possible. Avant de 
réaliser une interpolation, vous devrez donc bien comprendre comment chacune 
fonctionne, quels en sont les avantages et inconvénients, afin de choisir la méthode 
la plus adaptée à vos données de base et aux résultats attendus. L’  « ArcGIS Desktop 
Help » vous renseignera abondamment sur ces 3 méthodes (notamment en tapant 
dans l’index : « interpolation > overview of tools for (Spatial Analyst) »).  

2. Un cas particulier de l’interpolation spatiale est celui de la création d’un Modèle 
Numérique de Terrain (MNT) à partir d’un fichier de points contenant un champ 
avec l’information « altitude » à interpoler. Un MNT est une modélisation de 
l’altitude d’une surface (terrestre, par exemple). Les autres appellations du MNT 
sont : MNE (E pour Elévation), ou MNA (A pour Altitude)) ; DTM (en anglais – Digital 
Terrain Model), ou DEM (Digital Elevation Model). 

3.3.21.3. Créer un raster de pentes à partir d’un MNT. 

« Spatial Analyst » permet de dériver un « raster de pentes » à partir d’un « raster 
d’élévation ». Chaque cellule du « raster de pente » créé aura une valeur en degré ou en 
pourcent, renseignant sur l’importance de la pente en cet endroit. 
 
Pour dériver un « raster de pentes » à partir d’un « raster d’élévation » : 

 Cliquez sur « Spatial Analyst > Surface Analysis > Slope… » 
o Choisissez comme « Input surface : » le fichier d’élévation (MNT,…)  
o Choisissez comme « Output measurement : » des degrés.  
o Choisissez un « Z factor » adéquat.  (Notez que ce facteur correspond au nombre 

d’unités XY au sol compris dans une unité de la 3ème dimension Z). Le plus simple 
est de s’arranger pour avoir le raster d’élévation projeté dans un système de 
coordonnées utilisant des mètres comme unité linéaire en XY et que l’altitude 
soit également exprimée en mètres, ce qui permet d’utiliser un « Z factor »  égale 
à 1. 

o Choisissez la taille de cellule du fichier résultat « Output cell size: »  
o Enregistrez votre « Output raster : » dans le répertoire de travail, nommez-le et 

choisissez le type de format le plus adéquat (attention le format « ESRI GRID », ne 
tolère que un maximum 13 caractères). 

o Cliquez « OK » 
Votre raster de pentes  s’affiche dans ArcMap.  
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3.3.21.4. Reclassification des valeurs d’un raster 

« Spatial Analyst » permet de convertir les valeurs des cellules d’un raster selon des règles 
de classification. Cela peut-être utile, par exemple, pour transformer des  « classes de 
valeurs de pentes » en « valeurs de susceptibilité au glissement de terrain».  
 
Pour reclassifier les valeurs d’un raster : 

 Cliquez sur « Spatial Analyst > Reclassify… » 
o Choisissez comme « Input raster : » le raster à reclassifier 
o Choisissez comme « Reclass field : » le champ du raster contenant les valeurs à 

reclassifier 
o Dans le menu « Set values to reclassify », classifiez les valeurs actuelles du raster 

(« Old values »), éventuellement à l’aide du bouton « Classify… », selon les classes 
d’intérêt, et indiquez les nouvelles valeurs (« New values ») que ces classes 
prendront dans le fichier résultat. 

o Précisez le répertoire de sortie, le nom du fichier résultat et son format. 

3.3.21.5. Utilisation de la calculatrice de raster « Raster Calculator » 

« Spatial Analyst » permet de combiner les valeurs de plusieurs rasters via une formule 
mathématique à l’aide de l’outil « Raster Calculator ».  
  
Pour combiner les valeurs de plusieurs rasters: 

 Cliquez sur « Spatial Analyst > Raster Calculator… » 
o A l’aide de l’interface de la calculatrice qui apparait, tapez la formule combinant 

les rasters concernés. 
o Cliquez sur « Evaluate » 
o Le fichier résultant se nomme automatiquement en « Calculation » et s’ajoute 

dans la table des matières du projet ArcMap en cours. 
 
Attention, le fichier est enregistrer dans un répertoire temporaire et sera automatiquement 
effacé après un certain temps. Pour le conserver de manière définitive, faites un 

 « Clic droit >  Data > Export Data… » et sauvez le dans le répertoire et le format voulu. 
 
La symbologie du fichier peut-être modifiée pour une meilleure visualisation. 
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Contextualisation 8  
Contrat de rivière en Haïti et GIRE 

 
L’ONG québécoise « L’eau pour tous » commence un projet de développement 

 en Haïti sur le modèle des « contrats de rivières ». Le projet se focalise sur le bassin versant 
pilote de « Bombardopolis/Gonaïves » et l’une des premières étapes de ce projet est de 
réaliser une base de données géographiques de référence sur ce bassin. Vous devez identifier 
les limites géographiques de ce bassin versant.   
 
 
 
 
 
 
Pour ce faire vous disposez, dans le dossier «…\DATA\9 Watershed delimitation », des 
données suivantes : 

 «ASTGTM2_N19W073074_dem.tif », un modèle numérique de terrain de la zone 
avec une résolution spatiale horizontale de 30 m * 30 m. 

 « Watershed_pour_point.shp », un shapefile de type « point » représentant l’exutoire 
du bassin versant que vous voulez identifier. 

Les indications ci-dessous (section 3.3.21.6) vous aideront à réaliser cette étude. Vous 
travaillerez avec le projet ArcMap  «…\DATA\9 Watershed delimitation\Watershed 
delimitation in Haiti.mxd ». Utilisez la méthode de l’outil « Basin » uniquement.  
 

Contextualisation 8 : Contrat de rivière en Haïti 

3.3.21.6. Délimiter un bassin versant – « Basin » et « Watershed » 

La boite à outils « Spatial Analyst Tools / Hydrology » (dépendant de l’extension « Spatial 
Analyst ») permet de réaliser toute une série d’opérations en lien avec la modélisation 
hydrologique,  notamment la délimitation de bassins versants. 
 
2 méthodes sont présentées ci-dessous : 

1. Une méthode simple délimitant tous les bassins versants d’une zone donnée, à 
l’aide de l’outil « Basin » 

2. Une méthode complexe délimitant le bassin versant relatif à un exutoire donné, à 
l’aide de l’outil « Watershed ». 

 

Délimitation de tous les bassins versants d’une zone donnée à l’aide de l’outil 
« Basin » 
 
Cette méthode requière l’utilisation de : 

 un modèle numérique de terrain (MNT) de la zone contenant le bassin versant. 
 
Pour délimiter « tous » les bassins versants d’une zone donnée: 
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1. Créez un projet ArcMap avec définition du système de coordonnées du bloc de 
données 

2. Ajoutez le MNT dans votre interface ArcMap 
3. Utilisez, dans la boite à outils « Spatial Analyst Tools / Hydrology ». (Notez que 

certaines opérations peuvent prendre quelques minutes, selon la taille du bassin 
versant à délimiter). 

 La fonction « Fill » pour créer une surface du relief continue avec comme « Input 
surface raster » le MNT. (Le paramètre «Z limit (optional) » peut rester vide). 

 La fonction « Flow Direction » avec comme « Input surface raster » le résultat de 
l’opération « Fill ». (Le paramètre «Output drop raster (optional) » peut rester 
vide). 

 La fonction « Basin » avec comme « Input flow direction raster » le résultat de 
l’opération « Flow Direction ». 

 

Délimitation d’un bassin versant relatif à un exutoire donné, à l l’aide de 
l’outil « Watershed » 
 
Cette méthode crée un raster délimitant le bassin versant relatif à un exutoire donné. 
 
Cette méthode requière l’utilisation de : 

 un modèle numérique de terrain (MNT) de la zone contenant le bassin versant 

 un shapefile de type point contenant un point unique identifiant l’exutoire du bassin 
versant 

 
Pour délimiter un bassin versant relatif à un exutoire donné: 

1. Créez un projet ArcMap avec définition du système de coordonnées du bloc de 
données. Attention les « map units » (unité des coordonnées géographiques du 
projet ArcMap) influencent le paramètre « Snap Distance » de la fonction « Snap 
Pour Point » (confer ci-dessous). Les « map units » dépendent du système de 
coordonnées du bloc de données du project ArcMap, modifiable en faisant un clic 
droit sur le bloc de données puis en allant dans « Properties / Coordinates system » 
et en choisissant un système de coordonnées qui aura ces unités propres. Pour cet 
exercice assurez vous que le système de coordonnées est bien le système 
« Geographic Coordinate Systems / World / WGS 1984 » avec des degrés décimaux 
comme unités. 

2. Ajoutez le MNT et l’exutoire dans votre interface ArcMap 
3. Utilisez, dans la boite à outils « Spatial Analyst Tools / Hydrology ». (Notez que 

certaines opérations peuvent prendre quelques minutes, selon la taille du bassin 
versant à délimiter). 

1. La fonction « Fill » pour créer une surface du relief continue avec comme 
« Input surface raster » le MNT. (Le paramètre «Z limit (optional) » peut 
rester vide). 

2. La fonction « Flow Direction » avec comme « Input surface raster » le résultat 
de l’opération « Fill ». (Le paramètre «Output drop raster (optional) » peut 
rester vide). 
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3. La fonction « Flow Accumulation » avec comme « Input flow direction raster » 
le résultat de l’opération « Flow Direction ». (Les paramètres optionnels 
(« optional ») peuvent garder leur valeur par défaut). 

4. La fonction « Snap Pour point» avec comme 
 « Input raster or feature pour point data » le shapefile de point 

reprenant l’exutoire, 
  « Input accumulation raster » le résultat de l’opération « Flow 

Accumulation » 
 « Snap distance », exprimée en unités géographiques du projet 

ArcMap (confer ci-dessus). Une valeur correspondant à un peu plus 
que la distance séparant l’exutoire identifié dans votre fichier 
« exutoire » et l’exutoire réel, c’est-à-dire un peu plus que l’incertitude 
de localisation de l’exutoire. Dans cet exercice, prenez par exemple 
0.001 degré décimal (~= 300 mètres). Notez que l’exutoire fourni dans 
le fichier « Watershed_pour_point.shp » est localisé sur un pixel de 
« flow accumulation » et que donc la « Snap distance » pourrait être 
égale à 0. 

5. La fonction « Watershed» avec comme 
  « Input flow direction raster » le résultat de l’opération « Flow 

Direction »,  
 « Input raster or feature pour point data » le résultat de l’opération 

« Snap Pour point» 
Le raster résultant de cette dernière opération délimite le bassin versant défini par l’exutoire 
et le MNT utilisés. 
 
Pour plus d’information sur cette procédure, voyez dans « Help d’ArcGIS > Index >  
« Hydrology toolset (Spatial Analyst toolbox) > Learn about deriving runoff characteristics ». 
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3.3.21.7. Model builder 

Le « model builder » est une application d’ArcGIS qui permet d’enregistrer une séquence 
d’opérations, une chaine de traitements, afin d’en automatiser le fonctionnement. Cet outil 
est utile dans le cas où, par exemple: 

 une série d’opérations doit être réalisée un grand nombre de fois (l’insertion de 
variables est possible) 

 pour réaliser une illustration d’une chaine de traitements. 
 
Pour utiliser « Model builder » : 

 Cliquez sur le bouton « Model builder »  dans la barre « Standard » d’ArcGIS 

 Dessinez le modèle désiré : l’ajout d’outils ou de fichiers dans le modèle peut se faire 
par simple « cliqué-glissé » à partir d’  « Arc Toolbox » ou de la table des matières, 
vers l’interface du « Model builder ». 

 
La Figure 15 illustre l’utilisation de « Model builder » pour l’exercice de délimitation d’un 
bassin versant en Haïti ci-dessus.  

 
Figure 15 : Illustration de l’utilisation de « Model builder » pour la procédure de délimitation d’un 
bassin versant relatif à un exutoire donné, à l l’aide de l’outil « Watershed ». 
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3.3.22. Utiliser des lignes de commandes ou « Command line » 

Tous les outils disponibles dans ArcToolbox sous forme de « menu déroulant » ou « case à 
remplir » sont également disponibles sous forme de « Lignes de commandes » (« Command 

Line »).  Le bouton « Show / Hide Command Line Window »  de la barre d’outils 
« standard » permet l’affichage de l’interface pour accéder aux fonctions d’ArcToolbox sous 
forme de lignes de commande. Une fois cette interface ouverte, il vous suffit de taper le 
nom de l’outil que vous voulez utiliser dans la fenêtre supérieure (vous devez donc connaître 
préalablement quelle fonction utiliser). Une fois la fonction choisie, entrez un espace. Un 
encadré jaune vous indiquera l’ordre des paramètres à entrer pour cette fonction, tandis 
que les couches potentielles de ce paramètre apparaissent dans un menu déroulant. 
 

            
Figure 16 : Exemple d’utilisation de l’interface en « lignes de commandes » pour l’exécution 

d’outils ArcToolbox. 
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3.3.23. Enregistrement d’un projet ArcMap : « Chemin Relatif » ou 
« Chemin Absolu » ? 

L’enregistrement de votre document ArcMap peut se faire de deux manières différentes, 
selon la façon d’enregistrer le chemin (répertoire) indiquant au document ArcMap où sont 
stockées vos données sources (shapefile, raster, etc). Deux types de chemin existent :  

1. « Chemin Relatif » (ou « Relative path ») 
2. « Chemin Absolu » (ou « Full Path » ou « Absolute Path ») 

 

Exemple 
Considérons le cas de la Figure 17 ci-dessous, où le document ArcMap intitulé « Full and 
Relative path.mxd » contient l’unique donnée « ZAM-level_1.shp », un shapefile des 
divisions administratives de niveau 1 de la Zambie. 

 
Figure 17 : Répertoire à utiliser pour l’exercice sur le mode d’enregistrement en chemin relatif et 

absolu des documents ArcMap. 

 
Si le document est enregistré en « Chemin Absolu », le document ArcMap enregistrera le 
chemin vers le shapefile « ZAM-level_1.shp » comme :  

 D:\ Initiation ArcGIS SIG ACE\DATA\10 Full and Relative path\ 
ORIGINAL_PLACE\DATA\ZAM-level_1_SHP\ZAM-level_1.shp 

 
Par contre, si le document est enregistré en « Chemin Relatif », le document ArcMap 
enregistrera le chemin vers le shapefile « ZAM-level_1.shp » comme :  

 « ..\ DATA\ZAM-level_1_SHP\ZAM-level_1.shp ».  

Les 2 points « .. » indiquent que, à partir du document ArcMap, il faut d’abord remonter 

vers le dossier « PLACE_ORIGINALE ». Ensuite, il faut redescendre vers le fichier de données 
« ZAM-level_1.shp » en suivant le chemin « \DATA\ZAM-level_1.shp ». 
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Définitions 
 

1. Enregistrement en « Chemin Complet »  
Lors d’un enregistrement de type « Chemin Complet », le document ArcMap enregistre le 
chemin complet où sont stockées les données utilisées dans le projet ArcMap.mxd, depuis la 
lettre du disque dur à la racine, jusqu’au dossier contenant ces données.  

 
2. Enregistrement en « Chemin Relatif »  

Lors d’un enregistrement de type « Chemin Relatif », le document ArcMap enregistre le 
chemin reliant le document ArcMap aux données utilisées dans le projet ArcMap.mxd, et ce  
sans passer par la racine, mais en remontant jusqu’au premier dossier commun contenant le 
document ArcMap et ses données, puis en redescendant vers les données. 
Ce type d’enregistrement est à privilégier si le document ArcMap est susceptible d’être 
déplacé après sa création (envoi à un collègue, changement d’ordinateur, etc). Dans ce cas, il 
faudra veiller à ce que le document ArcMap et les données qu’il contient soient tous 
enregistrés dans un dossier commun facilement déplaçable. 
 

Pour choisir le type d’enregistrement (« Complet » ou « Relatif ») de votre projet 

ArcMap, dans la barre de menu d’ArcMap, 

 Cliquez sur « File > Document Properties > Data Source Options… ». 
o Choisissez d’enregistrer votre document.mxd (document ArcMap) en chemin 

« Complet » (par défaut) ou « Relatif ». 
o Cliquez « OK » 

 

Exercice 
 

 Ouvrez le document « Full and Relative path.mxd» 
Quels est le type d’enregistrement actuel ? (Réponse = « Relatif ») 

 Remarquez que le fichier « ZAM-level_1.shp » s’affiche correctement dans ArcMap 

 Fermez le document 

 Dans ArcCatalog, copiez le dossier « ORIGINAL_PLACE» contenant le document.mxd 
et le shapefile (clic-droit sur le dossier > Copy ») 

 Collez ce dossier dans le dossier « MOVE_HERE_1» (clic-droit sur le dossier > Paste) 

 Effacez le dossier « ORIGINAL_PLACE» initial (pas celui que vous venez de 
copier/coller) 

 Ouvrez le document ArcMap «  Full and Relative path.mxd» que vous venez de placer  
dans « \ MOVE_HERE_1\ ORIGINAL_PLACE \ »  

Le document s’ouvre-t-il correctement ? Pourquoi ? (Réponse : oui, car il est enregistré en 
« Chemin Relatif ». La donnée  « ZAM-level_1.shp » n’a pas bougé par rapport (ou 
« relativement ») au document ArcMap. Autrement dit, le chemin relatif est resté le même, 
malgré le déplacement du dossier contenant le document et ses données.) 

 Modifiez le type d’enregistrement de ce document en « Chemin Complet » 

 Enregistrez le sous le même nom et le même répertoire en cliquant sur la disquette 

 Fermez le document. 

 Dans ArcCatalog, copiez le dossier « MOVE_HERE_1» contenant le document.mxd et 
les données (« clic-droit sur le dossier > Copy ») 
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 Collez ce dossier dans le dossier « MOVE_HERE_2» (« clic-droit sur le dossier > 
Paste ») 

 Effacez le dossier « MOVE_HERE_1» se trouvant dans le dossier « 10 Full and Relative 
path » 

 Ouvrez le document ArcMap que vous venez de placer  dans « \ MOVE_HERE_2\ 
ORIGINAL_PLACE \ Full and Relative path.mxd» 

Le document ArcMap s’ouvre mais ne trouve pas le chemin jusqu’à la donnée « ZAM-
level_1.shp » car le chemin, de type complet, pointe vers un dossier n’existant plus.  
Pour réparer le chemin,  

 Faites un « Clic-droit sur la couche « ZAM-level_1.shp »  > Data > Repair Data 
Source… », et  

 Naviguez jusqu’au répertoire où se trouve votre donnée « ZAM-level_1.shp » :  
o D:\ Initiation ArcGIS SIG ACE\DATA\10 Full and Relative path\MOVE_HERE_2\ 

MOVE_HERE_1\ ORIGINAL_PLACE \DATA\ ZAM-level_1.shp.  
Le fichier « ZAM-level_1.shp » s’affiche à nouveau dans ArcMap. 
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3.3.24. Edition Cartographique. 

Réalisez une carte simple à partir de données de votre choix en suivant les consignes ci-
dessous. Un exemple de carte est donné en Annexe 3. 

 
La carte est un support particulièrement efficace pour communiquer les résultats de vos 
recherches. Elle permet en effet de synthétiser et de donner une vue d’ensemble sur une 
masse d’information parfois considérable en un seul coup d’œil. Il est très important de 
veiller à ce qu’elle soit la plus lisible, attractive et « parlante » possible, afin que la personne 
qui lira votre carte puisse comprendre aisément ce que vous avez décidé d’y représenter.  

 
Toute carte doit comporter les éléments suivants : 
 

 Un titre 

 Une échelle graphique (et accessoirement une échelle numérique) 

 Une légende 

 Une flèche indiquant le Nord 

 Informations relatives au système de coordonnées utilisé (Nom du système de 
coordonnées et datum,…) 

 Une grille de géo-référencement ou graticule 

 L’auteur (personne et / ou « Société ») 

 La date de création de la carte 

 Les sources et dates des données utilisées pour créer la carte 
Auxquels vous pouvez ajouter, entre autres : 

 Un rectangle d’emprise 

 Les références des cartes voisines (si votre carte fait partie d’un ensemble de cartes 
jointives) 

 
Edition cartographique dans ArcGIS. 
 
L’édition cartographique dans ArcGIS se réalise dans la fenêtre « Layout View » d’ArcMap.  

 Passez au mode « Layout View » d’ArcMap à l’aide du deuxième bouton de la barre 

d’outils (entouré ici d’un cercle rouge) contrôlant la fenêtre de 
visualisation.  

 

 Affichez (si ce n’est déjà fait) la barre d’outils de mise en page 

. Pour ce faire, 
o Cliquez sur le menu déroulant « Tools » de la barre de menu principale d’ArcMap 
o Choisissez « Customize… »  
o Dans l’onglet « Toolbars », cochez la case « Layout ». 
o Cliquez « Close » 
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3.3.24.1. Mode de mise en page « Portrait » ou « Paysage » et mises en 
page prédéfinies. 

Le mode de mise en page « Portrait » ou « Paysage » peut-être modifié via le menu principal 
d’ArcMap: « File > Print… > Setup… >  Paper > Portrait/Landscape > OK > Close». 
 
Des mises en page prédéfinies sont disponibles via le dernier bouton du menu de la barre 

d’outils de mise en page . 
 

3.3.24.2. Symbologie des données. 

La symbologie des données permet de représenter de manière plus intelligible les données 
représentées dans une carte à l’aide de couleurs, de gammes de couleur, de symboles, de 
graphiques, etc. 
 
Par exemple, la symbologie permettra : 

1. Appliquer un gradient de couleurs aux pays d’un shapefile des pays du monde en 
fonction des valeurs d’un de leurs attributs, par exemple, leur indice de 
développement humain (IDH) 

2. Appliquer des classes de couleur aux cellules d’un raster d’altitude en fonction de 
classes d’altitude. 

 
Pour avoir accès à toutes les fonctionnalités de la symbologie, 

 Cliquez-droit sur le nom de la couche 

 Choisissez « Properties > Symbology » 

 Choisissez le type de symbologie le mieux adapté à votre carte 
o Pour un fichier vectoriel,  

 « Features » : pour appliquer la même symbologie à toutes les entités 
spatiales d’un fichier 

 « Categories » : pour différencier des données de types catégorielles 
 « Quantities » : pour différencier des données de types quantitatives 
 « Charts » : pour utiliser des graphiques (bâtonnets, camemberts,…) 
 « Multiple Attributes » : pour utiliser une symbologie basée sur 

plusieurs attributs 
o Pour un fichier matriciel 

 « Unique Values » : pour attribuer une couleur unique à chaque valeur 
 « Classified » : pour attribuer une couleur par groupe de valeurs 

reprises dans une même classe 
 « Stretched » : pour « étirer » une gamme de couleurs sur les valeurs 

d’un raster 
 « Discrete Color » : pour appliquer un jeu de couleurs fixé à des 

données discrètes. 

 Cliquez « OK » 
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Pour un accès restreint à la symbologie, 

 Cliquez sur le symbole en-dessous du nom de la couche dans la table des matières 
o Clique-droit : accès à la palette des couleurs 
o Clique-gauche : accès à la palette des couleurs et aux types de symboles 

3.3.24.3. Etiqueter les données 

L’étiquetage des données vous permet d’afficher pour chaque entité spatiale (exemple : 
chaque province de Belgique), un attribut qui lui est associé dans la table d’attribut 
(exemple : le nom de la province). 
 
Pour étiqueter les données d’une couche, 

 Cliquez-droit, dans la table des matières, sur le nom de la couche que vous voulez 
étiqueter  

 Cliquez sur « Label Features » 
Une étiquette (ou « Label ») apparait sur chacune des entités spatiale de votre couche. Pour 
modifier ce label et ses propriétés,  

 Cliquez-droit, dans la table des matières, sur le nom de la couche, 

 Choisissez « Properties… > Labels » 

 Dans le menu déroulant « Label Field » de l’encadré « Text String », choisissez le 
champ de la table d’attribut de votre couche que vous voulez étiquetez. 

 Modifiez les propriétés d’affichage de l’étiquette (placement, taille, création 
éventuelle de classes d’entités à étiqueter différemment, etc) à l’aide des autres 
onglets et boutons si nécessaire 

 Cliquez « OK ». 
Une étiquette modifiée apparait sur chacune des entités spatiales de votre couche. 
 
Rem : il est possible de donner un aspect de « phylactère » aux labels en choisissant dans le 
menu « Labels » : « Symbol… > Properties > Advanced Text >  Indicate X and Y Offset and clic 
on Text Background > Properties > Balloon Callout ». 

3.3.24.4. Insertion des éléments indispensables sur une carte. 

Tous les éléments (sauf la carte elle-même et le graticule) peuvent s’insérer sur votre carte 
(encore en puissance) à l’aide du menu déroulant « Insert » de la barre de menu principale 
de ArcMap. 
 
Toute modification (taille, position, style, type, couleur,…) sur les éléments insérés se fait 
en  

 Sélectionnant l’élément à modifier par un clic gauche (en mode « layout view »), 

 Accédant à ses propriétés en faisant  un clic droit,  

 Choisissant l’onglet « Properties… » 
 

Insertion de la légende 
La légende insérée sur votre carte est interactive avec votre table des matières. Pour 
visualiser un élément de la légende, il faut que la couche y correspondant soit sélectionnée. 
Pour insérer une légende, 
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 Cliquez sur le menu déroulant « Insert » de la barre de menu principale d’ArcMap 

 Cliquez sur « Legend… » 

 Dans la fenêtre « Legend Wizard », 
o Sélectionnez à l’aide des simples et doubles flèches les couches que vous voulez 

renseigner dans la légende 
o Les grosses flèches noires permettent de modifiez l’ordre des couches 
o L’onglet « Preview » vous permet de pré-visualiser la légende que vous 

construisez 
o Ajustez les propriétés de la légende à l’aide des quelques fenêtres successives du 

« Legend wizard » auxquelles vous accédez en cliquant sur les onglets « Suivant ». 
o Cliquez sur l’onglet « Terminez » pour insérer votre légende. 

Votre légende apparait sur votre carte. 
 

Insertion de l’échelle 
 Cliquez sur le menu déroulant « Insert » de la barre de menu principale d’ArcMap 

 Cliquez sur « Scale Bar… » ou « Scale text » selon que vous désirez insérer une échelle 
graphique ou numérique. 

Une fenêtre contenant toute une série de types d’échelles apparait.  

 Sélectionnez le type d’échelle qui convient le mieux à votre carte 

 Modifiez ses propriétés (dont les unités, le nombre d’intervalles,…) si nécessaire à 
l’aide de l’onglet « Properties… » 

 Cliquez OK 
L’échelle s’affiche sur votre carte.  

 Modifiez sa taille et positionnez la correctement en cliquant dessus 
Faites attention à ce que l’échelle présentée soit « ronde », pour en faciliter la lecture. 

 Pour une échelle graphique, ajuster la longueur de la barre d’échelle pour que ses 
labels soient ronds, par exemple, 2000 m, ou 50 km, et non 810 m ou 42,31 km. 

 Pour une échelle numérique, ajuster votre « zoom » pour obtenir une valeur ronde, 
par exemple, 1/25 000  ou 1/100 000 et non 1/25 462 ou 1/99 985. 

 

Insertion de la flèche indiquant le Nord 
 Cliquez sur le menu déroulant « Insert » de la barre de menu principale d’ArcMap 

 Cliquez sur « North Arrow… » 
Une fenêtre contenant toute une série de flèches du Nord apparait.  

 Sélectionnez la flèche qui convient le mieux à votre carte 

 Modifiez ses propriétés si nécessaire à l’aide de l’onglet « Properties… » 

 Cliquez OK 
La flèche indiquant le Nord s’affiche sur votre carte.  

 Modifiez sa taille et positionnez la correctement en cliquant dessus 
 

Insertion du titre, de l’auteur, de la date de création de la carte, des sources 
des données et du système de coordonnée 
Toutes ces tâches peuvent être réalisées en insérant du texte sur votre carte 

 Cliquez sur le menu déroulant « Insert » de la barre de menu principale d’ArcMap 

 Cliquez sur « Text… » 
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Une zone de texte apparait sur votre carte. Pour l’éditer, double-cliquez dessus. L’onglet 
« Change Symbol… » vous sera utile pour modifier le style, la taille, la couleur des caractères 
et bien d’autres propriétés. 
 
Rem : il est possible d’insérer du texte sous forme de « phylactère » via le menu (en mode 
« Layout View ») : «  Insert > Text > Double clic sur le cadre du texte > Change Symbol… > 
Properties > Advanced Text >  Indicate X and Y Offset and clic on Text Background > 
Properties > Balloon Callout ». 
 

Insertion d’une grille de géo-référencement ou graticule 
La grille de géo-référencement permet de localiser votre carte dans l’espace. 

 Sélectionnez votre cadre de mise en page par un clic gauche 

 Cliquez-droit sur ce cadre 

 Choisissez « Properties… », et la fenêtre « Data Frame Properties » s’ouvre 

 Choisissez l’onglet « Grid » 

 Choisissez l’onglet « New Grid… » 

 Ajustez les propriétés de la grille à l’aide des quelques fenêtres successives 
auxquelles vous accédez en cliquant sur les onglets « Suivant ». 

 Cliquez sur « Finish » pour ajouter votre nouvelle grille dans la fenêtre « Data Frame 
Properties » 

 Cliquez sur « OK » pour ajouter cette grille à votre carte. 

3.3.24.5. Masquer automatiquement les zones de non intérêt lors de la 
mise en page d’une carte 

Il est parfois judicieux de ne représenter sur une carte qu’une zone bien déterminée, votre 
zone d’étude par exemple. Il est facilement possible dans ArcMap de masquer tout ce qui ne 
se trouve pas dans la zone d’intérêt, même si cette zone n’est pas définie par une emprise 
rectangulaire. 
 
Pour masquer automatiquement les zones de non intérêt lors de la réalisation d’une carte, il 
suffit de : 

 Avoir un shapefile (polygones) de la zone d’intérêt (les limites de la zone d’étude par 
exemple) et l’ajouter dans votre projet ArcMap 

 Faire un « Clic droit » sur le bloc de données (« layers ») et aller ensuite dans 
« Properties > Data frame > Clip to shape > Enable > Specify shape > Outlines of 
features» et sélectionner ensuite, dans le menu déroulant, le shapefile représentant 
la zone d’intérêt. Terminez en cliquant deux fois sur « OK ». 

3.3.24.6. Travailler avec plusieurs blocs de données. 

 Insert > Data Frame 
Un nouveau bloc de données s’insère dans votre projet ArcMap et devient « Actif ». Il 
apparait tout en bas de la table des matières comme un nouveau bloc de 

données , comme un nouveau cadre actif dans le « Layout View », et 
comme le seul bloc de données visible dans le « Data view ».  
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Il n’est possible de travailler que sur un bloc de données « Actif ». Pour activer / désactiver 
un bloc de données, 

 Soit, dans la table des matières, faites un clic droit sur le bloc de données et cliquez 
sur « Activate » 

 Soit, dans le mode « Layout view », sélectionnez la cadre de données correspondant 
au bloc que vous voulez activer. 

Un seul bloc de données peut être actif. L’activation d’un bloc désactive donc 
automatiquement les autres blocs.  
 
Une tâche particulière que permet la manipulation de plusieurs blocs de données 
simultanément est la Création d’un rectangle d’emprise. 
 

Création d’un rectangle d’emprise  
Un rectangle d’emprise permet de localiser graphiquement la zone étudiée (un pays par 
exemple) au sein d’une plus grande entité (le monde par exemple) à l’aide d’un rectangle 
correspondant à la zone étudiée placé sur la grande entité. Un rectangle d’emprise est utilisé 
sur la carte reprise en Annexe 3. 
 
Pour créer un rectangle d’emprise, 

 Cliquez sur « Insert > Data Frame » 

 Ajoutez la couche « Communes » dans ce nouveau bloc de données 

o Soit avec le bouton  lorsque le bloc de données est activé 
o Soit en cliquant-droit sur le bloc de données dans la table des matières et en 

choisissant le bouton « Add Data… » 
En mode « Data view », vous ne visualisez que ce nouveau bloc. Alors que en mode « Layout 
view », vous avez maintenant deux blocs de données. Arrangez-les pour qu’ils ne se 
superposent pas.  

 Dans le « Layout View », sélectionnez le bloc de donné « New Data frame » 

 Cliquez-droit > Properties > Extent rectangles (rectangle d’emprise) 

 Dans l’encadré « Other data frames » sélectionnez le bloc de données qui constituera 
le rectangle d’emprise dans votre « New Data frame » (dans ce cas-ci, le bloc de 
données « Layers » et  

 Faites le passer dans l’encadré « Show extent rectangle for these data frames » à 
l’aide de la simple flèche vers la droite. 

 Cliquez « OK » 
Un rectangle d’emprise correspondant au Zoom actuel de votre bloc « Layers » apparait 
dans votre bloc de données « New Data frame ». 

3.3.24.7. Exportation d’une carte. 

Pour exporter votre carte depuis ArcMap vers un format plus simple (JPEG, PDF,…) et 
communicable à d’autres personnes non-utilisateurs d’ArcGIS : 

 Dans la barre de menu principale, allez dans « File > Export Map… » 

 Dans la fenêtre « Export Map » qui apparait, naviguez vers votre répertoire de sortie, 
nommez votre fichier-carte, choisissez le format voulu (JPEG, PDF,…) ainsi que la 
résolution désirée (300 dpi (dot per inch) est souvent sufisant). 
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Annexe 1 -  Les 10 commandements pour utiliser 
correctement ArcGIS 

 
1. Concernant l’organisation et l’enregistrement de vos données : 

 Enregistrez toutes vos données (projet ArcMap, données géographiques, etc) 
dans un même dossier (qui peut contenir des sous dossiers) afin d’avoir une 
vision claire de l’organisation vos données et d’en faciliter la manipulation 
éventuelle (envoi de projet ArcMap à un collègue,…).  

 Enregistrez toujours votre projet en «chemin relatif » si vous comptez partager 
votre projet avec d’autres personnes ou simplement déplacer le projet vers un 
autre dossier ou ordinateur. 

2. Manipulez (déplacer, copier, coller, renommer) toujours vos fichiers via « ArcCatalog » 
et non via « Windows explorer » (pour 1 fichier apparaissant dans « ArcCatalog », 
plusieurs fichiers apparaissent dans « Windows explorer »). 

3. Concernant les systèmes de coordonnées : 

 Toujours identifier le système de coordonnées le plus adéquat pour votre zone 
d’étude 

 Lors de la création d’un nouveau projet ArcMap, toujours définir le système de 
coordonnées du bloc de données 

 Lors de l’importation de nouveaux fichiers, toujours vérifier le système de 
coordonnées, et si celui-ci est manquant, le définir à l’aide de la fonction 
« Define » (à condition de savoir dans quel système est votre fichier). 

4. Concernant l’affichage d’éléments : 

 Lorsqu’une fenêtre (un panneau) disparait, vous pouvez la (le) faire réapparaitre 
via le menu « Window » dans la barre de menu principale d’ArcMap en 
sélectionnant la fenêtre à faire apparaitre. 

 Pour faire apparaitre une barre d’outils, utilisez le menu « View / Toolbars » et 
sélectionnez-la. 

5. Certaines fonctionnalités d’ArcGIS (ex : « Spatial Analyst ») sous soumises à l’activation 
d’une extension (activable si vous avez la licence pour cette extension). Cette activation 
se fait via le menu « Tools / Extensions / … » 

6. Après avoir travaillé avec une sélection, il vaut mieux tout désélectionner à l’aide du 

bouton «  » afin de ne pas réaliser les opérations suivantes sur une sélection non 
désirée 

7. Lors de la création d’un fichier « nom_du_fichier_EVENTS » (fichier temporaire) suite à 
une manipulation, exportez ce fichier en shapefile pour l’enregistrer de manière 
permanente (« clic droit sur la couche à exporter / data / export data ») 

8. Lors de la réalisation d’une carte, n’oubliez pas d’y insérer tous les éléments 
indispensables (titre, échelle, légende, source et date des données, flèche du Nord, 
auteur et date de création de la carte, système de coordonnées, grille de 
géoréférencement) 

9. Un « clic droit » (sur le nom de la couche dans la table des matières ou ailleurs) vous 
donnera souvent accès à des fonctionnalités utiles 

10. Lorsque vous réalisez une opération, vérifiez toujours à posteriori si le résultat fourni 
par le logiciel correspond bien à ce que vous pensiez faire. 
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Annexe 2 -  Outils fréquemment utilisés dans ArcCatalog 
(Lien vers  « Utiliser l’assistant de géotraitement ») 

 

Nom de 
l’Outil 

Utilité de l’outil Schéma Chemin dans ArcToolbox 

Merge 
Fusion de 

différentes 
entités spatiales 

 

 

Buffer 

Création d’une 
zone tampon 
autour d’une 

entité spatiale 
 

Intersect 
Intersection de 
deux fichiers de 

formes 

 

Union 
Union de deux 

fichiers de 
formes 

 

Clip 

Extraction des 
entités « input » 
qui superposent 
l’entité de coupe 
(« Clip Feature ») 

 

Dissolve 

Agrégation 
d’entités 

spatiales sur base 
d’un attribut 

spécifié. 
 

Figure 18 : Outils fréquemment utilisés dans ArcCatalog 
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Annexe 3 -  Exemple de carte d’occupation du sol 
(Lien vers  « Edition cartographique ») 

 

 
Figure 19: Carte d'occupation du sol réalisée dans ArcGIS à partir de la classification supervisée 

d'une image satellite SPOT 5 
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Annexe 4 -  Fiche technique pour l’importation de points (GPS 
par exemple) dans ArcGIS à partir d’un tableur 

(Lien vers  « Ajouter des données ponctuelles XY (GPS par exemple) à partir d’un tableur (Excel ou 
Access par exemple) ») 

 
Remarque préliminaire: il est normalement possible d’importer les données d’un GPS 
(points, lignes, polygones) automatiquement dans ArcMap dans le format « shapefile ». 
Cependant il peut arriver que les points GPS aient été transcrits dans un cahier de terrain et 
que vous ne possédiez plus que ces notes. Vous devrez donc encoder ces informations dans 
un tableur et suivre la procédure ci-dessous pour l’importation dans ArcMap. 
 
Afin d’importer des points GPS depuis un tableur  vers un projet ArcMap, vous devrez suivre 
les 4 étapes ci-dessous. 

 
1. Analyse de vos données ponctuelles dans le tableur. 
 
Vous devez connaitre ou identifier : 

 Le système de coordonnées dans lequel vos points sont exprimés. L’opérateur qui a 
fait les relevés GPS doit posséder cette information en principe. 

 Les unités utilisées. Cela peut être par exemple, des mètres, kilomètres, degrés-
minutes-secondes (dms) ou degrés décimaux (dd), etc 

 
Il faut que le système de coordonnées de vos points soit compatible avec ArcMap. C’est le 
cas la plupart du temps. Sinon il faut convertir vos coordonnées. Il existe toute une série de 
petits logiciels gratuits sur le web pour réaliser des conversions de coordonnées d’un 
système vers un autre. A vous de cherchez le logiciel qui pourrait vous aider. 
 
Si vos coordonnées sont exprimées en degrés-minutes-secondes, il faudra les convertir en 
degrés décimaux. Un exemple est donné ci-dessous : 
 

Degrés Minutes Secondes 

Conversion 
en dd 
 

Degrés décimaux (dd) 

45 25 55 = 45 + (25/60) + (55/3600) 
= 45.532 degrés décimaux 

 Il y a 60 minutes 
dans 1 degré 

Il y a 3600 secondes 
dans 1 degré 

 

 
De plus, selon la localisation de votre zone d’étude, vous devrez identifier si vous travaillez 
dans l’hémisphère nord ou sud. 
 
2. Organisation de vos données dans le tableur. 

 
Vous devrez arranger vos données de la manière suivante : 

 1ère ligne = nom des colonnes, par exemple : 
o X ou longitude 
o Y ou latitude 
o Z ou altitude 
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o Obsevration 1 
o Observation 2 
o Etc 

 Le nom des colonnes doit être simple : 
o Pas d’espace 
o Pas de caractères spéciaux (% , / - etc) 
o Nom court (10 caractères maximum ?) 

 Les lignes suivantes doivent contenir les valeurs de manière continue (pas de ligne 
vide) 

 
L’exemple suivant vous donne les coordonnées en mètres (dans le système de coordonnées 
Lambert belge 72) de quelques stations météo belges à partir duquel vous pouvez tenter 
l’exercice d’importation dans ArcMap : 

 La table 1 est exemple correcte 

 La table 2 est un exemple de ce qu’il ne faut pas faire, avec en rouge les « erreurs »  
 
Table 1    Table 2   

STATION X Y  STATION météo X (m) Y (m) 

Arlon-Aive 254950 42327  Ligne en trop   

Athus 256446 28543  Arlon-Aive 254950 42327 

Aubange 253784 29016  Athus 256446 28543 

Balmoral 258071 134418  Aubange 253784 29016 

Bastogne 246273 76403  Balmoral 258071 134418 

Battice 253146 149370  Bastogne 246273 76403 

    Battice 253146 149370 

 
 
3. Importation de vos données GPS dans ArcMap à partir d’Excel. 
Voir la section 3.3.12.2 ou suivez la procédure ci-dessous : 

 Ouvrez un projet ArcMap 

 Définissez le système de coordonnées de votre bloc de données 

 Cliquez sur le menu déroulant « Tool » dans la barre de menu principale d’ArcMap 

 Sélectionnez « Add XY Data… »  

 Naviguer vers votre tableur et sélectionnez le tableur et la feuille (le cas échéant) du 
tableur d’intérêt. 

 Sélectionnez les champs de votre tableur qui correspondent aux coordonnées X-
longitude et Y-latitude des points à importer. 

 Spécifier le système de coordonnées dans lequel sont exprimés vos points à l’aide du 
bouton « Edit… ». Deux possibilités s’offrent à vous: 

o « Select », pour naviguer vers le système de coordonnées de vos points XY. 
o « Import », pour importer le système de coordonnées à partir d’un fichier de 

données géographiques déjà existant et ayant le même système de 
coordonnées que celui de vos points XY. 

 Cliquez « OK ». 
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Les points s’affichent à présent dans ArcMap (sinon, faites un zoom to layer, point 3.3.6.) et 
la couche « nom_du_fichier_events _Events» s’est ajoutée dans la table des matières de 
votre projet. Cette couche ne représente pas encore un « véritable shapefile » permanent et 
réutilisable. Pour en créer un, vous devez encore l’exporter, en shapefile par exemple. Pour 
ce faire : 

 Cliquez droit sur la « nom_du_fichier_events _Events» 

 Choisissez « Data > Export Data » 

 Choisissez « shapefile » comme type de fichier à produire 

 Gardez les options par défaut du menu d’exportation (« All features » et « this  layer’s 
source data ») 

 Choisissez le répertoire de sortie.  

 Nommez votre fichier 

 Cliquez « OK » 

 Ajoutez le fichier dans votre interface ArcMap 
 
 
4. Contrôle du résultat 
 
Vous devrez toujours contrôler le résultat obtenu. Ceci peut se faire : 

 Par comparaison du positionnement de vos points GPS par rapport à d’autres 
données de références, par exemple un shapefile de limites administratives, etc 

 Par vérification de la logique du positionnement de vos points par rapport aux 
coordonnées : par exemple, dans l’hémisphère nord, si un point « a » a une valeur de 
y plus grande que celle du point « b », le point « a » devra se situer au dessus (plus au 
Nord) du point « b »  
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Annexe 5 -  Descriptions et sources des données 

 

Nom du fichier Description Source 
Africa_countries_only.shp Pays d’Afrique Dérivé de « countries_shp » 

AKBAR Basilan Island Philippines 
SIG_P_Community map.png 

Carte d’aménagement du territoire de l’île 
Basilan aux Philippines 

Créé 

AKBAR_Community map_GEOREF.tif Carte « AKBAR Basilan Island Philippines 
SIG_P_Community map.png » géoréférencée 

Créé 

ASTGTM2_N19W073074_dem.tif Modèle Numérique de Terrain (MNT) d’une 
région en Haïti  

http ://gdem.ersdac.jspacesyste
ms.or.jp/ 

ASTGTM2_S09W056_dem_clip_m.tif Modèle Numérique de Terrain (MNT) d’une 
région au Brésil 

Basilan windmill project.shp Localisation de projets éoliens aux Philippines Créé 

Cotton_parcel_Yanle.shp Parcelles de coton d’un village au Mali Fictif 

countries_shp.shp Pays du monde http://www.diva-gis.org/Data  

Excel sheet.xls Exemple de feuille Excel Créé 

GAB_satellite_trimmed.tif Image satellite du Gabon http://www.maplibrary.org 

guat_lucp.jpg Carte écologique du Guatemala  http://eusoils.jrc.ec.europa.eu/
esdb_archive/eudasm/latiname
rica/maps/guat_lucp.htm  

Haiti.shp Frontières d’Haïti  Dérivé de « countries_shp » 

India_population_per_district.shp Population indienne par district d’Inde http://www.diva-
gis.org/datadown 
complété à l’aide de : 
http ://en.wikipedia.org/wiki/Li
st_of_districts_in_India_by_pop
ulation  
 

Indus_downstream_Tarbela_Dam_10k
m_buffer.shp 

Zone tampon de 10 km de part et d’autre du 
fleuve Indus en aval du barrage de Tarbela au 
Pakistan 

Dérivé de 
« 10m_river_lake_centerlines.s
hp » 

Line_Features.shp Réseau hydrographique imaginaire de Tasmanie Créé 

MALI.shp Mali Dérivé de « countries_shp” 

NuclearReactors2011.lyr Fichier de symbologie associé à 
«NuclearReactors2011.shp» 

Créé 

NuclearReactors2011.shp Nuclear power stations around the world in 2011 http://www.sharegeo.ac.uk/ha
ndle/10672/202  
Fichier simplifié par rapport à 
l’original. 

Personal Geodatabase.mdb Exemple de géodatabase Créé 

Point_Features.shp Points imaginaires en Tasmanie Créé 

Points of interest of this course.shp Localisation des exercices de ce TP SIG sur la 
carte du monde 

Créé 

Polygone_Features.shp Polygones imaginaires dans la mer de Tasmanie Créé 

Populated_places_PAKISTAN.xls Principales zones peuplées du Pakistan Dérivé de 
« 10m_populated_places.shp » 

Rivers Raster établissant la proximité du réseau 
hydrographique de  « Paraisoverde » dans la 
forêt brésilienne 

Créé 
 

Rivers.shp  Approximation du réseau hydrographique de  
« Paraisoverde » dans la forêt brésilienne 
 

Créé 

http://gdem.ersdac.jspacesystems.or.jp/
http://gdem.ersdac.jspacesystems.or.jp/
http://www.diva-gis.org/Data
http://www.maplibrary.org/
http://eusoils.jrc.ec.europa.eu/esdb_archive/eudasm/latinamerica/maps/guat_lucp.htm
http://eusoils.jrc.ec.europa.eu/esdb_archive/eudasm/latinamerica/maps/guat_lucp.htm
http://eusoils.jrc.ec.europa.eu/esdb_archive/eudasm/latinamerica/maps/guat_lucp.htm
http://www.diva-gis.org/datadown
http://www.diva-gis.org/datadown
http://en.wikipedia.org/wiki/List_of_districts_in_India_by_population
http://en.wikipedia.org/wiki/List_of_districts_in_India_by_population
http://en.wikipedia.org/wiki/List_of_districts_in_India_by_population
http://www.sharegeo.ac.uk/handle/10672/202
http://www.sharegeo.ac.uk/handle/10672/202
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Rivers of Eritrea AFRICOVER.shp Réseau hydrographique d’Erythée  http ://www.fao.org/geonetwo
rk/   

Soil survey.lyr Fichier de symbologie associé à « Soil 
survey.shp  » 

Créé 

Soil survey.shp  Shapefile de points correspondant à un 
échantillonnage de sol, localisés par GPS, et  
établissant le type de sol et sa susceptibilité aux 
glissements de terrain. 

Créé 

undp_gdp_per_capita_and_human_de
velopment_index_world_2005.shp 

Indice de développement humain par pays http://geocommons.com/overl
ays/2069  

utm_zones_final.shp  Zones UTM du monde http://www.enviroprojects.org/
geospatial-services/gis-
resources/global-utm-
zones/view  

Watershed_pour_point.shp Exutoire d’un bassin versant en Haïti Créé 

ZAI.shp Régions administratives de la RDC http://www.maplibrary.org   

ZAI_satellite_trimmed.tif Image satellite de la RDC 

ZAM-level_1.shp Régions administratives de la Zambie 

10m_populated_places.shp Principales villes du monde http://www.naturalearthdata.c
om/downloads/  10m_river_lake_centerlines Principaux fleuves du monde 

110m_populated_places.shp Principales villes du monde 

50m_ocean.shp Océans 

12_villages_type_and_water_require
ment.dbf 

Table indépendante contenant des informations 
relatives au fichier 
« 12_villages_around_Dinangourou.shp » 

Créé 

12_villages_around_Dinangourou.lyr Fichier de symbologie associé à 
« 12_villages_around_Dinangourou.shp » 

Créé 

12_villages_around_Dinangourou.shp Position de villages au Mali Dérivé en partie de 
« populated_place.shp » mais 
avec données fictives 

50_wells_around_Dinangourou.lyr Fichier de symbologie associé à 
« 50_wells_around_Dinangourou.shp» 

Créé 

50_wells_around_Dinangourou.shp Position de puits au Mali Créé 

http://www.fao.org/geonetwork/
http://www.fao.org/geonetwork/
http://geocommons.com/overlays/2069
http://geocommons.com/overlays/2069
http://www.enviroprojects.org/geospatial-services/gis-resources/global-utm-zones/view
http://www.enviroprojects.org/geospatial-services/gis-resources/global-utm-zones/view
http://www.enviroprojects.org/geospatial-services/gis-resources/global-utm-zones/view
http://www.enviroprojects.org/geospatial-services/gis-resources/global-utm-zones/view
http://www.maplibrary.org/
http://www.naturalearthdata.com/downloads/
http://www.naturalearthdata.com/downloads/
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Annexe 6 -  Sites internet intéressants en SIG 

 

Category Nom Adresse Descriptif 
Free / 
open 

source 

Formation 
ArcGIS 

GEEAU 
http://www.ge-

eau.org/index.html 

TP « Initiation à ArcGIS » appliqué 
à gestion des ressources en eau 

pour l'agriculture au Burkina Faso 
! Données non disponibles ! 

Yes 

Web GIS 

Google Earth http://www.google.fr/earth
/index.html  

The world – satellite images and 
landmarks 

Yes 

Google Maps https://maps.google.com/  Street of the world Yes 

OpenLayers http://openlayers.org/  To put a dynamic map in any web 
page 

Yes 

OpenStreetMap http://www.openstreetmap
.org/  

Carte du monde librement 
modifiable, faite par des gens 

comme vous. 
Yes 

wikimapia http://www.wikimapia.org/
  

?? Yes 

Sources de 
données 

ASTER-GDEM http ://gdem.ersdac.jspaces
ystems.or.jp/  

ASTER-GDEM World digital 
elevation model at 30 m spatial 

resolution 
Yes 

Populated places in 
the world 
 

http://www.fao.org/geonet
work/srv/en/metadata.sho
w?id=12690    

Shapefile of populated places in 
the world 

Yes 

GeoNetwork http://www.fao.org/geonet
work/   

FAO GIS database Yes 

Protectedplanet.ne
t 

http://www.protectedplane
t.net/   

World Database on Protected 
Areas (WDPA) 

Yes 

Natural Earth http://www.naturalearthda
ta.com/  

Free vector and raster map data 
at 1:10m, 1:50m, and 1:110m 

scales 
Yes 

DIVA-GIS http://www.diva-
gis.org/Data   

 Yes 

VMAP1 http://www.mapability.com
/index1.html?http&&&ww
w.mapability.com/info/vma
p1_index.html  

World Vector Map Level 1, 
resolution is based on 1:250,000 

Yes 

Map Library http://www.maplibrary.org
/  

Basic map data concerning 
administrative boundaries in 

developing countries 
Yes 

Free GIS, Remote 
Sensing, Spatial & 
Hydrology Data 

http://free-gis-
data.blogspot.be/  

Blog providing many links to free 
GIS, Remote Sensing, Spatial & 

Hydrology Data 
yes 

AfricaMap http://worldmap.harvard.e
du/africamap/  

Wide source of data focusing on 
Africa 

Yes 

http://www.ge-eau.org/index.html
http://www.ge-eau.org/index.html
http://www.google.fr/earth/index.html
http://www.google.fr/earth/index.html
https://maps.google.com/
http://openlayers.org/
http://www.openstreetmap.org/
http://www.openstreetmap.org/
http://www.wikimapia.org/
http://www.wikimapia.org/
http://gdem.ersdac.jspacesystems.or.jp/
http://gdem.ersdac.jspacesystems.or.jp/
http://www.fao.org/geonetwork/srv/en/metadata.show?id=12690
http://www.fao.org/geonetwork/srv/en/metadata.show?id=12690
http://www.fao.org/geonetwork/srv/en/metadata.show?id=12690
http://www.fao.org/geonetwork/
http://www.fao.org/geonetwork/
http://www.protectedplanet.net/
http://www.protectedplanet.net/
http://www.naturalearthdata.com/
http://www.naturalearthdata.com/
http://www.diva-gis.org/Data
http://www.diva-gis.org/Data
http://www.mapability.com/index1.html?http&&&www.mapability.com/info/vmap1_index.html
http://www.mapability.com/index1.html?http&&&www.mapability.com/info/vmap1_index.html
http://www.mapability.com/index1.html?http&&&www.mapability.com/info/vmap1_index.html
http://www.mapability.com/index1.html?http&&&www.mapability.com/info/vmap1_index.html
http://www.maplibrary.org/
http://www.maplibrary.org/
http://free-gis-data.blogspot.be/
http://free-gis-data.blogspot.be/
http://worldmap.harvard.edu/africamap/
http://worldmap.harvard.edu/africamap/
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Sources de 
données 

ASTER GDEM http://gdem.ersdac.jspacesyst
ems.or.jp/ 

Modèle numérique de terrain 
mondial à une résolution spatiale 

de 30 m * 30 m. 
Yes 

 http://www.ccafs-
climate.org/data/   

Data Provided by the CGIAR 
Research Program on Climate 
Change, Agriculture and Food 

Security (CCAFS) 

Yes 

Logiciels 

QuantumGIS http://www.qgis.org/  La référence SIG libre !! 

(licence GPL) 
Yes 

DIVA-GIS http://www.diva-gis.org/  Free GIS software Yes 

XTOOLS-PRO http://www.xtoolspro.com/   Set of useful vector spatial 
analysis, shape conversion, and 

table management tools for 
ArcGIS 

No (15 
days 
free 
trial) 

GME - Geospatial 
Modelling 
Environment 
 

http://www.spatialecology.
com/gme/gmedownload.ht
m   

GIS analysis tools. Previously 
known as Hawth's Analysis Tools 

Yes 

R  http://www.r-project.org/  Free statistical software with a 
raster modul 

Yes 

Forum 
GeoRezo http://georezo.net/  Le portail francophone de la 

géomatique 
/ 

Forum SIG http://www.forumsig.org/  Forum SIG  

Belgique - 
divers 

Géoportail de la 
Wallonie 

http://geoportail.wallonie.b
e/ 

La cartographie au service des 
wallons 

Yes 

Sources de 
données 
géographiques, 
FUNDP, Namur  

http://www.fundp.ac.be/sci
ences/geographie/etudiant
s/sources-de-donnees-
geographiques  

Ressources cartographiques, de 
télédétection, socio-

économiques, des programmes 
SIG 

Yes 

Géoportails 

EUROPE http://inspire-
geoportal.ec.europa.eu/ 

  

BRUXELLES http://geoloc.irisnet.be/   

FRANCE http://www.geoportail.gou
v.fr/accueil 

  

ALLEMAGNE http://www.geoportal.de/   

SUISSE http://map.geo.admin.ch/   

ITALIE http://www.pcn.minambien
te.it/viewer/ 

  

TUNIS http://www.daleeli.tn/   

 

  

http://gdem.ersdac.jspacesystems.or.jp/
http://gdem.ersdac.jspacesystems.or.jp/
http://gdem.ersdac.jspacesystems.or.jp/
http://www.ccafs-climate.org/data/
http://www.ccafs-climate.org/data/
http://www.qgis.org/
http://www.gnu.org/copyleft/gpl.html
http://www.diva-gis.org/
http://www.xtoolspro.com/
http://www.spatialecology.com/gme/gmedownload.htm
http://www.spatialecology.com/gme/gmedownload.htm
http://www.spatialecology.com/gme/gmedownload.htm
http://www.r-project.org/
http://georezo.net/
http://www.forumsig.org/
http://geoportail.wallonie.be/
http://geoportail.wallonie.be/
http://www.fundp.ac.be/sciences/geographie/etudiants/sources-de-donnees-geographiques
http://www.fundp.ac.be/sciences/geographie/etudiants/sources-de-donnees-geographiques
http://www.fundp.ac.be/sciences/geographie/etudiants/sources-de-donnees-geographiques
http://www.fundp.ac.be/sciences/geographie/etudiants/sources-de-donnees-geographiques
http://inspire-geoportal.ec.europa.eu/
http://inspire-geoportal.ec.europa.eu/
http://geoloc.irisnet.be/
http://www.geoportail.gouv.fr/accueil
http://www.geoportail.gouv.fr/accueil
http://www.geoportal.de/
http://map.geo.admin.ch/
http://www.pcn.minambiente.it/viewer/
http://www.pcn.minambiente.it/viewer/
http://www.daleeli.tn/


 

Initiation à ArcGIS  Arlon Campus Environnement  94 

 

Annexe 7 -  Conseils pour campagne de terrain avec utilisation 
de GPS 

 
Exemple : relevé d’occupation du sol dans la zone d’étude d’un TFE 
 

 Apprendre à utiliser le GPS avant de partir pour toutes les manipulations à faire sur place 
(prises de points, navigation, définition du système de coordonnées, chargement des 
données sur un pc (avoir installé éventuellement un logiciel adéquat sur le pc) 

 Si vous travaillez avec une image (de Google Earth ou autre), « étudiez » votre image 
avant de partir pour cibler les endroits difficilement photointerpretables qui feront 
l’objet d’une attention toute particulière une fois sur le terrain. De même, identifiez et 
localisez précisément les endroits devant faire l’objet d’investigation particulière (pour 
peu que la zone d’étude soit étendue, il est généralement pratiquement impossible de se 
rendre en tout point de la zone). Planifiez votre travail avant de partir. 

 A prendre avec: 
o GPS et les câbles associés pour se connecter à l’ordinateur 
o Des piles/batterie en suffisance (les journées de terrain peuvent être longues) et 

le chargeur adapté avec éventuellement un adaptateur selon le pays de 
destination. Si vous faites de longues journée en voiture avec un ordinateur et un 
GPS, prévoir un convertisseur AC-DC. 

o Éventuellement imprimer une carte-image (de Google Earth par exemple) de la 
zone d’étude en suffisamment bonne résolution que pour reconnaitre les 
éléments du paysage une fois sur place (1/20 000 par exemple). Imprimer un jeu 
de cartes si nécessaire (grande zone). Ces cartes-images papier peuvent être 
utiles en cas de défaillance du GPS sur place (pour prendre note directement sur 
la carte) ou pour s’orienter par rapport à l’image. Pour la réalisation des cartes-
images, utiliser une grille de géoréférencement, dans le même système de 
coordonnées et avec les mêmes unités que ce que vous utiliserez avec le GPS (en 
général en WGS1984). 

o Utiliser des unités en mètre si possible, qui sont plus parlantes sur le terrain que 
des degrés (pour estimer les distances, les grandeurs). Les cartes-images peuvent 
être glissées dans des fardes plastiques sur lesquelles il est possible d’écrire au 
marqueur indélébile. Cela peut-être utile en cas de pluie ou d’humidité 
importante du milieu (forêt) par exemple. Prendre des marqueurs, bics, crayons 
en suffisance de même qu’un cahier de terrain pour noter vos observations et 
remarques.  

o Sac à dos pour faciliter le transport de tout le matériel 
o Appareil photo numérique, pour documenter vos relevés (une photo vaut mieux 

qu’un long descriptif dans votre cahier de terrain), illustrer une carte (l’enrichir). 
Remarque : possibilité dans ArcGIS de créer des hyperliens entre un shapefile de 
relevé (des points par exemple) et une base de données-images.   


